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LICENSE AGREEMENT

This is a legal agreement between you (either an 
dividual or an entity) and Luckman Interactive, Inc
By opening the sealed software package and/or us
the software, you agree to be bound by the terms
this Agreement.  If you do not agree to the terms 
this Agreement, promptly return the disk package
and accompanying items (including printed mater
als and binders or other containers) to the place y
obtained them for a full refund.
1.  Grant of License.  Luckman Interactive, Inc. per-
mits you to use one copy of the Luckman Interactiv
product (the "SOFTWARE").  The Software is in 
"use" on a computer when it is loaded into the tem
porary memory (i.e., RAM) or installed into the pe
manent memory (e.g., hard disk, CD-ROM, or oth
storage device) of that computer, except that a co
installed on a network server for the sole purpose
distribution to other computers is not "in use."  Com
ponent parts of the Software may not be separated
use by more than one computer or more than one u
at any time.  If the anticipated number of users of t
Software will exceed the number of applicable Li-
censes, then you must have a reasonable mechan
or process in place to ensure that the number of p
sons using the Software concurrently does not ex
ceed the number of licenses.
2.  Copyright.   The Software is owned by Luckman
Interactive, Inc. and Kevin Flick and is protected b
United States copyright laws and international trea
provisions.  Therefore, you must treat the Softwar
like any other copyrighted material (e.g., a book o
musical recording) except that you may either (a) 
make one copy of the Software solely for backup 
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License Agreement
This is a legal agreement between you (either an individual or an entity) and Luckman Interactive
By opening the sealed software package and/or using the software, you agree to be bound by the
of this Agreement. If you do not agree to the terms of this Agreement, promptly return the disk pa
and accompanying items (including printed materials and binders or other containers) to the plac
obtained them for a full refund.

1 Grant of License. Luckman Interactive permits you to use one copy of the Luckman Interactive p
uct (the “SOFTWARE”). If this package is a License Pak, you may make and use additional copie
the Software up to the number of Licensed Copies authorized. The Software is in “use” on a com
when it is loaded into the temporary memory (i.e., RAM) or installed into the permanent memory 
hard disk, CD -ROM, or other storage device) of that computer, except that a copy installed on a 
work server for the sole purpose of distribution to other computers is not “in use”. If the anticipate
number of users of the Software will exceed the number of applicable Licenses, then you must ha
reasonable mechanism or process in place to ensure that the number of persons using the Softw
currently does not exceed the number of licenses.

2 Copyright. The Software is owned by Luckman Interactive, Inc., and is protected by United Stat
copyright laws and international treaty provisions. Therefore, you must treat the Software like any
copyrighted material (e.g., a book or musical recording) except that you may either (a) make one
of the Software solely for backup or archival purposes, or (b) transfer the Software to a single har
provided you keep the original solely for backup or archival purposes. You may not copy the writt
materials accompanying the Software.

3 Other Restrictions. This license is your proof of license to exercise the rights granted herein and 
be retained by you. You may not rent or lease the Software, but you may transfer your rights und
agreement on a permanent basis provided you transfer this License, the Software, and all accomp
printed materials, retain no copies and the recipient agrees to the terms of this License. You may
reverse engineer, decompile, or disassemble the Software, except to the extent the foregoing res
is expressly prohibited by applicable law.

Disclaimer of Warranty
The Software (including instructions for its use) is provided “as is” without warranty of any kind. L
man Interactive, Inc., further disclaims all implied warranties including without limitation any impli
warranties or merchantability or of fitness for a particular purpose. The entire risk arising out of th
or performance of the software and documentation remains with you.

In no event shall Luckman Interactive, its authors, or anyone else involved in the creation, product
delivery of the software be liable for any damages whatsoever (including, without limitation, dama
for loss of business profits, business interruption, loss of business information, or other pecuniary
arising out of the use of or inability to use the software or documentation even if Luckman Interac
Inc., has been advised of the possibility of such damages. Because some states/countries do not
the exclusion or limitation of liability for consequential, or incidental damages, the above limitation 
not apply to you.

U.S. Government Restricted Rights
The Software and documentation are provided with RESTRICTED RIGHTS. Use, duplication, or 
closure by the government is subject to restrictions as set forth in subparagraph (c)(1)(ii) of The R
in Technical Data and Computer Software clause at DFARS 252.227-7013 or subparagraphs (c)(
(2) of the Commercial Computer Software - Restricted Rights 48 CFR 52.227-19 as applicable. M
facturer is Luckman Interactive, Inc., 6430 Sunset Boulevard, Suite 1518, Hollywood, CA 90028

If you acquired this product in the United States, this Agreement is governed by the laws of the S
California.
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Welcome to the Internet
It’s the topic of the decade and the promise of the future. Not si
the introduction of the personal computer itself has a single tech
logical event promised such profound possibilities. From Los 
Angeles, to London, to Moscow, it has become a household wo
You can’t pick up a newspaper or magazine without at least on
in-depth article about how it has the potential to change the ver
fabric of society. It’s a business tool, an education resource, a 
communication network, a financial center, world-wide shoppin
mall, global mailbox, and entertainment superstore. 

It’s the Internet. 

What began in 1969 as a simple, yet technologically advanced 
for government scientists to correspond and share research wi
colleagues has grown into the world’s largest computer network
On any given day you will find 25 or so million ordinary (and som
rather extraordinary) people taking part in this electronic revolut
called the Internet. 

Because of its size, its availability, and its ease of use, the Inte
is rapidly transforming and redefining modern communications
research techniques, and sources of entertainment. It is also red
ing how people are using their personal computers. In and of its
the Internet is cited by many new buyers as the reason they wa
PC in their homes. 

The Internet is a link — an interactive link — to the world. 

What exactly is the Internet?
At its most basic level, the Internet is a giant library open 24 ho
a day, 7 days a week, 365 days a year. People use the Internet
publish information and to find information. The original and 
principal benefit of the Internet is to share ideas and knowledge w
other people.
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In the last few years, however, the Internet has also become so
thing else: the world’s largest shopping mall. Once you have 
finished your research at the library, you can then go shopping 
anything you might want, from an on-line version of Moby Dick, to 
a review of the latest John Grisham novel, to a new winter coat
Whatever it is you are after, you will surely find it (or sell it) on th
Internet.

Technically, the Internet is comprised of over 3 million individua
computers (called hosts) that are connected together around th
world through a series of networks. 

Each host stores information — text, graphics, pictures, sounds
videos — on every imaginable subject. Hosts (also called serve
and sites) are usually maintained by a specific entity that contro
the information available on that server. For example, NASA op
ates a host, so does Stanford University, the Library of Congres
the White House, IBM, ABC, the Department of Energy, Microso
and so on. This diversity is what makes the Internet so interest
No single person, organization or government controls it all. Th
available information runs the full gamut of human interests. An
everyone with a personal computer and a modem has access to it. It 
is the world’s single largest source of information. 

With WebEdit PRO, you can just as easily create your own Inter
(World Wide Web) content as IBM or Microsoft and become an 
on-line publisher with access to millions of people around the 
world. 

A Brief History

The Internet was developed in 1969 by the Department of Defen
Advanced Research and Projects Agency (ARPA). Initially, the 
ARPANet, as it was called then, was designed as a Cold War de
sive strategy, thought to be less vulnerable than typical comput
networks’ methods for transferring information. Rather than 
sending a file as a whole, information was (and still is) transferr
over the Internet in “packets”, small pieces of information, a little
a time. Once they reach their destination, the packets are 
re-assembled back to their original form. That way, should a sin
network go down, there is less risk of losing all the information.
iv, Welcome to the Internet
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By the 1980’s, the military went its own way and the Internet 
became the exclusive property of universities and other governm
tal agencies. NASA, the Department of Energy, and the Nation
Institutes of Health soon added their own networks. 

Then came the supercomputer centers and the corporations. B
1990, the Internet had become the largest e-mail network in the
world. Its ability to publish and transfer full documents, includin
graphics, sound and images, made it a very popular interface. 

Today, nine out of 10 sites added to the Internet are commercia
nature selling everything from soap to tires, real estate to balloo
This explosive growth has made the Internet as dynamic and div
as the population itself.

As more and more organizations and individuals become publish
of information (and not just users), the growth, availability and 
variety of Internet information and services will continue to expa
at geometric rates. 

Networks — Lots of Them

Just as your own computer stores information on its hard disk, so
Internet might be thought of as a series of very big (to put it mild
hard disks. 

If you have two computers in your office or home and you conn
them together, you can access information from both computer
hard disks. This same concept is true with the Internet, althoug
now you have 3 million--plus computers connected by over 40,0
individuals networks which are available for you to access. 

A network is the method by which all these computers share in
mation (how they are hooked or linked together). The Internet ta
the concept of networks to its logical conclusion — it doesn’t ju
link up computers, it links up the networks themselves, forming
network of networks. This means people in Japan can access a
puter in Ireland or Sweden or Peru as easily (or more easily) as they 
can a site in their own hometown. 

Additionally, the Internet is far from complete. It’s a work in 
progress. Everyday, another computer joins the network, and 
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another thousand people log on. It’s estimated that the Internet
growing at the rate of approximately 10% a month!

What’s on the Internet? The better question is, what isn’t on the In-
ternet?

The World Wide Web
Recently, the Internet, like the rest of the computer world, has g
far beyond displaying information in the traditional text format. 
With the advent of hypertext, a computer language that easily al-
lows you to link documents and files, the Internet is now a multim
dia center combining text, sound, graphics, even video. Users a
publishers are no longer restricted to reading information — the
can see it, hear it, and respond to it (called “interactive computin

The World Wide Web (WWW or the Web) is the fastest growing
segment of the Internet for its ability to display information in a 
multimedia format. If the Internet is growing at 10% a month, th
Web is growing at 20%. There are an estimated 10,000 Web ser
in over 80 countries around the world accessed by millions of peo-
ple each day. Communications, marketing and commerce have 
become an international affair with an unlimited potential for 
reaching a new and ever growing cyperspace population. 

The Web, like the Internet itself, was originally developed as a t
for researchers to easily access information. This is still true tod
The Web has developed into something much more, however. It
become a virtual on-line shopping mall and playhouse. Everyon
from General Motors and IBM, to Joe’s Shoe shack is selling th
goods and services on their own Web home page. There are ga
videos and music. You don’t need to go any further than your o
PC to find the largest “shopping mall” in the world. And when it
comes to entertainment, this interactive powerhouse is slowly o
taking television as the focal point of the family den.

Like everything else on the Internet, however, the WWW is so la
and complex that you will find just about anything you can imagi
somewhere on a Web site. 

For example, you’ll find:
vi, Welcome to the Internet
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Education  — The Web continues to be one of the world’s grea
scholarly lending libraries. Leading research centers around th
world put their newsletters, papers, research programs and con
ence results on the Web. The ability to incorporate text with gra
ics and photographs has made the Web a mecca for serious res

Entertainment  — You’ll find Web sites for music, drama, televi
sion, the movies, whatever your interest. Listen to the latest sin
from a favorite recording artist or view a clip from this summer’
blockbuster movie. Play computer games, view paintings from 
some of the finest museums in the world, or check out the latest 
Trek offering.

Commerce  — The Web is a shoppers’ paradise. Review a colo
catalog and order on-line. Buy cars, computers, stocks, or real 
estate. Find consultants, lawyers, and doctors. You’ll even find 
want ads with employment opportunities in just about every city
the world.

Government  — Review the workings of Congress or your loca
city council. Every day another city, country, region, state and 
national government organization opens a new Web site. This i
electronic democracy at its infancy and your chance to get invol

The most recent and potentially significant development on the
World Wide Web is its transformation to the corporation as an 
internal information distributor. More and more organizations ha
taken the technology of the Web and the communicative power
the Internet to set up an internal server, or Intranet. Aside from
obvious benefits as a central distributor of information, the Web 
be an inexpensive solution to a single information platform whe
information can be published, displayed and accessed using 
existing hardware. Additionally, the ability to publish information
immediately, to do so inexpensively, and to make it available wo
wide are proving to be very strong magnets to this form of 
communication.

Without question, the World Wide Web is quickly becoming the
“printing press” of the 1990’s.
 Welcome to the Internet, vii
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How does the WWW Work?

The WWW uses a computer language called hypertext. This easy 
to use language allows documents to be linked to other docum
for non-linear access to information. For users, this means they
get from one place to another by simply clicking a mouse on a w
or graphic. Because users are not restricted from going from sit
to B to C, but can navigate in an almost circular fashion, most W
browsers allow users to track their path, and save favorite Web s
to a “hotlist” allowing for easy return. 

For publishers, hypertext has made designing, programming an
publishing information easier and more efficient than ever. The
beauty of the Web is that it does not matter what type of a comp
a user has (IBM-compatible, Macintosh, Sun workstation) or the
erating system they are using (OS/2, Windows, Mac OS, or Un
as long as their Web browser adheres to Web standards (and m
do), they can connect to any Web server. 

Web Terminology

Like any technology, the Web uses its own terms which you wil
find helpful as either a Web user, publisher, or content provider.
fer to the Glossary at the end of this user’s guide for complete de
nitions of common jargon, technical references and other 
“Web-speak”.

Where to Go From Here
The remainder of this book looks at the issues and procedures
need to know in order to use WebEdit PRO and “create the per
Web document”.

Start with Chapter 1, Installing WebEdit PRO.
viii, Welcome to the Internet
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Introduction
Every page you see on the World Wide Web began as a humble
file. What makes it look special on the Web is HTML—Hypertex
Markup Language, a system of page-markup "tags" that contro
how Web browsers display everything you see in a Web docum
text, graphics, tables, frames, animations, and most important o
links to other documents. (If you have any familiarity with 
SGML—Standard Generalized Markup language, from which 
HTML is derived—you are already know many basic HTML 
concepts.)

Luckman’s WebEdit PRO 2.0 is a full-featured, professional 
HTML document authoring and editing tool, yet it is extremely ea
to use. Your source document is always visible for convenience 
control, and you can immediately see the effects of any change
the HTML document using WebEdit PRO’s Quick Preview 
window.

This user’s guide explains how to get started using WebEdit PR
to create and edit HTML documents. It also gets you started us
the built-in tools and wizards that make advanced HTML featur
such as frames, tables, and forms simple and quick to create. A
complete WebEdit PRO reference is included in the online Help
which you should refer to first when you have a question that is 
addressed in this book.

While it is beyond the scope of this user’s guide to present a co
prehensive introduction to HTML, WebEdit PRO’s online Help 
includes a complete HTML reference (through the unofficial ver
sion 3.2, plus Netscape and Internet Explorer extensions). At th
time of this writing, the officially approved standard is HTML 2.0
this is the version of HTML that is currently supported by the wide
range of browsers.

At the end of this user’s guide you will find a basic introduction 
HTML and a summary of the most common HTML tags, along w
the Web addresses of additional HTML references and tutorials
HTML is constantly evolving, and the Web is the perfect resour
for keeping up to date on official HTML standards, proposed 
standards, discussions, and authoring tips.
Introduction,I-3
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WebEdit PRO Features

WebEdit PRO offers you the following powerful features:

• Unlimited number and size of documents  — WebEdit 
PRO's rich interface lets you work on an unlimited number of
HTML documents simultaneously. The size of each documen
limited only by your computer's memory.

• HTML dialogs  — WebEdit PRO has specially designed dialo
boxes for defining anchors and links, inline images and figure
forms, tables, etc., including a URL Builder for rapid creation 
Uniform Resource Locators. Additionally, WebEdit PRO save
every URL you enter, letting you choose from a list rather tha
retyping the same URLs over and over.

• Quick Previewer  — WebEdit PRO's quick preview utility is a
quick and easy way to preview your HTML documents. It sup
ports all HTML tags up to and including HTML 2.0. It also sup
ports HTML 3.0 Forms and Tables.

• Browser support  — Whatever Windows-based browser you
use, you can link it into WebEdit PRO to test your HTML doc
ments at the click of a button. WebEdit PRO allows you to 
instantly choose from any number of browsers.

• Open Location  — You can open HTML files directly from the
Internet.

• Home Page Wizard  — Helps you create your first page in a 
flash!

• Add-on modules  — WebEdit PRO includes the following 
add-on modules:

- WYSIWYG frame wizard

- WYSIWYG form designer

- HTML tag checker

- FTP upload facility

- Link validation wizard

- Table of contents wizard

- Multimedia wizard
I-4, Introduction
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• HTML 3.2, Navigator 3.0 and Internet Explorer 3.0 tags  
— WebEdit PRO supports all the latest tags helping keep yo
web pages on the cutting edge!

• HTML tag highlighting  — Tags can be displayed in a 
contrasting color.

• HTML reference  — WebEdit Pro’s online Help extensively 
documents each HTML tag and its attributes. HTML version 
and browser support information is also included.

• Document Structure elements  — Document structure tags
such as <HTML>, <HEAD>, <TITLE>, <BODY>, etc., are all 
supported, including HTML 3 and Netscape-specific attribute

• Block Formatting elements  — WebEdit PRO supports all 
HTML block formatting tags, such as <ADDRESS>, <BLOCK
QUOTE>, and <PRE>, plus HTML 3 extensions such as 
<NOTE>.

• Logical Font Formatting elements  — Every logical for-
matting tag and attribute from HTML version 1 through HTML
version 3.2 is included, from standard tags such as code and
tion, to new proposed tags such as person, acronym, etc.

• Physical Font Formatting elements  — Blinking text, bold, 
italics, underlining, typewriter text, emphasis, strong emphas
font sizing, etc. It's all in here.

• List and miscellaneous elements  — Select a block of text 
and choose Numbered List or Un-numbered List, and WebEd
PRO automatically inserts list-item tags on each line. WebEd
PRO also includes all standard insertion tags such as <P>, 
<HR>, <BR>, etc.

• Special characters  — WebEdit PRO includes support for the
entire ISO Latin character set, allowing you to easily insert 
extended ANSI characters into your documents. WebEdit PR
also includes support for special characters such as "<", ">",
"&", non-breaking spaces, and more.

• Form elements  — Create web forms quickly and easily with
WebEdit PRO's built-in Form support.

• Table elements  — HTML 3 defines a new syntax for display
ing tabular information. 
Introduction,I-5
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• WYSIWYG table builder  — To simplify the creation of 
HTML tables, WebEdit PRO also includes a WYSIWYG table
builder; you simply enter your data in a spreadsheet-style gri
and WebEdit PRO writes the HTML for you.

• Client-Side image mapping  — WebEdit PRO's Map Builder 
allows you to visually divide images into different hotspots.

• User-defined elements  — If there are any HTML tags or 
other text you enter regularly that are not already built-into 
WebEdit PRO, you can add them to WebEdit PRO's User-
Defined Tags dialog box for easy insertion into your documen
You can even add filenames into the dialog box for larger "ins
tion macros". Selecting a filename in the User-Defined Tags 
dialog tells WebEdit PRO to insert the contents of the file into
the current document.

• Non-standard tags and attributes  — WebEdit PRO 
includes support for non-standard tags and attributes, such a
those recognized by Netscape Navigator (font sizing, special
image alignment, etc.) and HTML 3.2. These tags and attribu
are ignored by other browsers, but are included in WebEdit P
in case you need them.

• HTML removal  — WebEdit PRO lets you quickly and easily 
remove HTML tags from any document or portion of a docu-
ment. Simply highlight the text from which to remove HTML 
tags, and click the Remove HTML Tags button.

• Multi-lingual Spell Checker  — Correct the spelling of your 
documents directly within WebEdit PRO using our built-in spe
checker.

• Document export  — WebEdit PRO allows you to save your 
HTML documents in either UNIX or Macintosh format. No 
more strange characters when using different platforms!

• Shortcut keys  — Keyboard shortcuts (e.g., Ctrl-B for Bold-
face) are provided for all of the most common tags.

• Configurable toolbars  — Configure WebEdit PRO to work 
the way you do! Put whatever buttons you want, in any order,
the toolbar by dragging and dropping.

• Tooltips  — Every field on every dialog has popup tooltips tha
provide a brief explanation of the purpose or use of the field, 
reducing the amount of time you will spend looking things up
I-6, Introduction
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• Right-click menu  — Right-clicking on any document pops up
a menu that allows you to close or save the file, or choose fro
list of the most common HTML tags to insert in your docume

• Project support  — Organize all of your HTML files into 
projects and then load all of those files with the click of a butto

• Third-party add-on module support - Users can write their 
own add-on modules for WebEdit PRO using the WebEdit PR
API.

Document Design Tips
Regardless of how you format your Web documents, keep in m
that pages may display differently on different computers using
different Web browsers. For example, fonts will generally be bas
on the fonts used by the browser, not by the HTML document. 
Additionally, HTML text automatically conforms to the size of th
browser window. Finally, bear in mind that not all browsers can
interpret every available HTML element.

Therefore, when designing your documents, limit your fonts to 
more popular font families (e.g., Times, Helvetica, Courier, and
on) and design your documents with your users in mind. If you h
several browsers installed on your system, WebEdit PRO lets y
easily view any document you create in any of the available 
browsers, so that you can test how it will display.

When creating a new document from scratch, it is usually more
efficient to enter the text of your document first, and then add th
desired HTML markup tags to the document. For the more comp
elements such as forms, frames, and tables, WebEdit PRO incl
tools and wizards that lead you step-by-step through entering t
necessary information and then automatically generate the 
appropriate HTML.
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Using the WebEdit PRO User’s Guide
This user’s guide will show you how to install WebEdit PRO an
provides instructions for using it.

Specifically, the user’s guide contains the following chapters:

Welcome to the Internet — This brief introduction to the 
Internet and the World Wide Web is provided for those of you w
may wish to see a quick review of the history, technology, and 
potential of the Information Superhighway. 

Introduction  — Another brief introduction to Web publishing an
what you will find in this user’s guide.

Chapter 1, Installing WebEdit PRO — This chapter takes you
step-by-step through the installation process, including the elect
ic registration option and how to submit a product report to 
Luckman Interactive.

Chapter 2, Getting Started — Explains how to start and exit 
WebEdit PRO, and how to use the Quick Preview window. This
chapter also details WebEdit PRO menus and toolbars.

Chapter 3, Creating New Documents — Shows you how to 
create a document including how to use the Home Page Wizar
HTML tags, hyperlinks, anchors, and images.

Chapter 4, WebEdit PRO Tools — Shows you how to use the
table builder, form builder, frame wizard, table of contents wiza
link validation wizard, and how to upload files to a Web server.

Chapter 5, Configuring WebEdit PRO — Explains how to 
change WebEdit PRO configurations.

Chapter 6, Introduction to HTML — Reviews basic HTML 
concepts and tags, including special characters, custom tags, a
SSI tags.

Glossary — Defines many of the more common Internet terms

You should use this user’s guide as a an on-going reference gu
for questions arising in the future.
Introduction
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On-Line Help Documentation
The .PDF on-line manual is a complete electronic version of th
hard copy printed manual. It is located in the WebEdit PRO 
folder. The file can be viewed using Adobe’s Acrobat Reader. 

Technical Support
If you require assistance, you may contact Luckman Interactive
Technical Support Team as follows:

Voice (213) 614-1758

Fax (213) 614-1929

E-Mail support@luckman.com

Technical Support hours are 8:30 am - 5:00 pm Pacific Time, 
Monday through Friday.

When calling Technical Support, please have your product regis
tion number handy and be at your computer, so that we can get
up and running quickly.

Thank you for choosing WebEdit PRO! We’re confident you’ll fin
it the most powerful tool available for creating exciting Web 
content. 
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Overview 
Installing WebEdit PRO is a straightforward and simple process
An advanced setup program automates the often confusing and
consuming aspects of installing new software. By following the
detailed step-by-step screen prompts, you will be ready to crea
your Web site content in a very short time. 

This chapter helps you install WebEdit PRO onto your compute
contains the following information and procedures:

• Hardware requirements

• Software requirements

• Installation and electronic registration procedures

• Creating a product report

Once you complete the installation and registration process, yo
will be ready to create your Web documents and content, taking
advantage of all that this exciting technology has to offer.

Hardware Requirements
The following hardware requirements represent the minimum 
configuration that is supported by WebEdit PRO:

• 486 or later IBM PC or compatible computer

• 8 MB RAM (16 MB recommended)

• Hard disk with at least 7 MB free space for a full installation

• Double-speed CD-ROM

• Mouse
 Installing WebEdit PRO, 1-3
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 



WebEdit PRO User’s Guide
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . 

er 

al-

ge, 

t 
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Software Requirements
The following software must be installed on your computer in ord
to run WebEdit PRO:

• Windows 95, or Windows NT 3.5.1 or later 

Installing WebEdit PRO
You should not be running any other application during the inst
lation of WebEdit PRO. Additionally, it is always good policy to 
backup your computer before installing any new software packa
including this one. 

To install WebEdit PRO:

1 Insert the WebEdit PRO CD into your computer’s CD drive.

2 If you are running Windows 95, the WebEdit PRO Setup 
Welcome dialog automatically displays as long as you have no
disabled the CD Notification option. 

WebEdit PRO Setup Welcome dialog
1-4, Installing WebEdit PRO
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If you are running Windows NT, or if you have disabled CD Not
fication in Windows 95, choose the Run command from the File
menu (or from the Start button). The Run dialog displays. 

Run dialog

3 Type X:\SETUP.EXE (X=your CD drive). The WebEdit PRO 
Setup dialog displays. 

Be sure you are not running any other Windows applications dur
the installation process. If you are, click Cancel, close the runn
application(s) and begin again with Step 1.

4 When the Welcome dialog displays, click Next. 

The Registration dialog displays.

Type X:\SETUP.EXE 
and click OK.

X = your CD drive
 Installing WebEdit PRO, 1-5
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Registration dialog

5 Type your name, company name, as desired, and your WebEd
PRO serial number. The serial number is printed on your CD 
package or Registration Card.

6 Click Next.

The Registration Confirmation dialog displays.

Registration Confirmation dialog

7 If the information is correct, click Yes. If it is incorrect, click No 
and repeat the installation process. 

Type your name, company 
name, serial number and 
click Next.

The serial number will be 
used as a reference number 
should you need to 
contact technical support.

You will find the serial 
number on the CD package 
or on your Registration 
Card.
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The Choose Destination Location dialog displays.

Choose Destination Location dialog

8 This dialog allows you to select where you wish the WebEdit PR
files copied. Accept the default location C:\Program Files\
WebEdit\, or click Browse to select another location.

9 Click Next.

The Folders Selection dialog displays.
 Installing WebEdit PRO, 1-7
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Select Folder dialog

10 This dialog allows you to specify the folder in which to install th
WebEdit PRO files. The default folder is WebEdit . After making 
a selection, click Next. 

The WebEdit PRO files install on your computer. In a moment,
message displays giving you the opportunity to register WebEd
PRO by e-mail.

E-Mail Registration Message

11 Click Yes to register WebEdit PRO by e-mail now, or No to clos
the message. You can select to register WebEdit PRO by e-ma
later from the WebEdit PRO program folder, or by choosing the
Start button, then Programs/WebEdit/Email Registration.
1-8, Installing WebEdit PRO
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If you selected Yes, a Mail Server dialog displays.

Mail Server dialog

12 Enter your mail server’s domain name. This information can be
located in your e-mail application’s Configuration/Options men
command. After entering the information, press Next. The 
WebEdit PRO Registration dialog displays:

WebEdit PRO Registration dialog

13 Enter the following information:
 Installing WebEdit PRO, 1-9
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14 Click Next. 

A Questionnaire dialog displays.

Field Description

Licensed By Select the appropriate license.

First Name Enter your first name.

Middle Initial Enter your middle initial.

Last Name Enter your last name.

Company Enter your company name, as appropriate.

Mail Address Enter you street mailing address.

City Enter your city.

State Enter your state.

Zip Code Enter your full postal zip code.

Country Enter your country (e.g., USA).

E-mail Address Enter your e-mail address, as appropriate.

Phone Enter you telephone number including area
code.

Where did you 
purchase the 
product

Enter the store (or catalog) where you 
purchased WebEdit PRO.
1-10, Installing WebEdit PRO



Installing WebEdit PRO
 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . 

er 
ore 
the 

is-
 

n 
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Questionnaire dialog

15 Answering the questionnaire will help Luckman Interactive bett
understand its users, which in turn will make future products m
responsive to your needs. Please take a moment and answer 
four questions by clicking on the applicable buttons.

16 When finished with the Questionnaire, click OK.

17 If you selected No in Step 11 to register WebEdit PRO by 
e-mail now, a message displays informing you that you can reg
ter the program later from the WebEdit PRO folder. Click OK to
close the message.

A message displays giving you the opportunity of viewing the 
WebEdit PRO Readme file which contains important informatio
about the application.

Open Readme File dialog

18 Click Yes to open the Readme file, or No to close the dialog.
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The WebEdit PRO folder displays.

WebEdit PRO Folder

You are now ready to use WebEdit PRO.

Enjoy!

Uninstalling WebEdit PRO
If you wish to uninstall WebEdit PRO and are running Windows 
or Windows NT 4.0, choose the Add/Remove Programs comma
from the Control Panel. If you are running Windows NT 3.5.1, 
choose the Uninstall WebEdit command from the WebEdit folde

Sending a Product Report
Luckman Interactive is interested in your experience with worki
with WebEdit PRO and has provided a method for you to quick
and easily contact us about problems or product suggestions b
creating a wizard driven product report.

To create a product report:

1 Choose the Product Report icon from the WebEdit folder, or 
choose the Start button, then Programs/WebEdit/Product Repo
1-12, Installing WebEdit PRO
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The Product Report Welcome dialog displays.

Product Report Welcome dialog

2 Click Next.

The User Information dialog displays.

User Information dialog

3 Enter the following information:
 Installing WebEdit PRO, 1-13
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4 Click Next. 

The Hardware Configuration dialog displays.

Hardware Configuration dialog

Field Description

Name Enter your full name.

Company Enter your company name, as appropriate.

Address Enter you street mailing address.

City Enter your city.

State Enter your state.

Zip Code Enter your full postal zip code.

Country Enter your country (e.g., USA).

Phone Enter you telephone number including area
code.

Fax Enter you fax telephone number including 
area code.
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5 WebEdit PRO reviews your system hardware configuration and
displays the results. If they are incorrect, use the drop-down list
correct the information.

After validating or correcting your hardware configuration, click
Next. The Product Information dialog displays.

Product Information dialog

6 Select WebEdit PRO from the Product Name drop-down list.

7 Enter the following information:

• Product Version Number (e.g., 1.0)

• Product Component (for which you are making a report)

• Product Serial Number

• Registered User (name)

8 Click Next. The Software Configuration dialog displays.

This dialog collects 
information about 
the product and 
component for 
which you are mak-
ing a product report.
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Software Configuration dialog

9 Enter the following information:

• Operating System you are using (e.g., Windows 95)

• Major version number (e.g., 3, if you are using Windows 3.1)

• Minor version number (e.g., 1, if you are using Windows 3.1)

10 Click Next. 

The Product Report Message dialog displays.

Product Report Message dialog

Enter the information 
you wish to send to 
Luckman Interactive 
about the product.
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11 Enter the information about the product you wish to send to Lu
man Interactive and click Next.

The Product Report Information dialog displays.

Product Report Information dialog

12 Enter the following information:

13 After entering the information, click Next.

Field Description

File Name Enter a name for your report using a .TXT 
extension. Reports are by default saved in t
ProdRept folder. To change this location, 
click the Browse button and select another
folder.

Report Options By default, reports are sent to Luckman 
Interactive by E-mail. Make sure the E-mai
checkbox is checked. You can also save a
copy of the report and print a copy of the re
port by clicking the applicable checkboxes.

Server Name Enter LUCKMAN.COM.

Your Address Enter your E-mail address so Luckman Inte
active can reply to you.
 Installing WebEdit PRO, 1-17



WebEdit PRO User’s Guide
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

. . . . . 

an 
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

The Save the Selections dialog displays.

Save the Selections dialog

14 Click Finish to save your report and close the wizard.

15 Connect to the Internet, open your E-mail program, select the 
product report .TXT file as an attachment, and send it to Luckm
Interactive.

Thanks in advance for working with us to make better Internet/
Intranet products!
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Overview
In this chapter you will learn how to launch WebEdit PRO; tour t
main window, menus and toolbars; and learn how to exit the pr
gram.

Starting WebEdit PRO
WebEdit PRO is launched from the WebStudio folder or from th
Start menu.

To start WebEdit Pro:

1 Click the Start button, then choose Programs/WebEdit/WebEd
PRO. The WebEdit PRO main window displays. 

WebEdit PRO main window (new document)

The main window is a standard Windows 95 application window
containing a menu bar, toolbars, control menu, and status bar. 
can move the window on your desktop, re-size it, minimize, or 
maximize it.

Document 
window

Document 
toolbar

User 
toolbar

Menu 
toolbar

Status Bar
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Each time you start WebEdit PRO, a new, empty document is 
opened by default, and the Quick Preview window is turned off.

Quick Preview Window
Once you start entering the contents of an HTML document, yo
can check how the document is likely to appear when displayed
a browser by opening the Quick Preview window. Click the "ligh
ning bolt" button on the document toolbar to toggle the Quick 
Preview window on and off.

Document and Quick Preview windows

You can open as many documents as you like, and switch betw
them by clicking on the tabs at the top of the document area. Y
can also use the shortcut key Ctrl-Tab to switch between docum

Additionally, the width of the document and Quick Preview 
windows may be adjusted using the vertical "splitter bar" just to 
right of the up/down scroll bar. Just drag the vertical splitter bar 
or right.

By default, the quick previewer only displays in the right half of t
document window. If you prefer to use the full window for 
previewing, choose Configure from the Options menu and choo

Document window

Quick Preview window

Splitter bar

Quick Preview Button
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Full Screen Preview on the Previewer tab. In this mode, you can
the quick previewer button to toggle between editing and displa

WebEdit PRO’s Quick Preview window is "HTML 2.0-compliant.
That is, if you limit yourself to using only tags that are part of th
HTML 2.0 standard, what you see in the Quick Preview window
will be what users will see when they view the document with th
browsers. However, if you use tags that are not part of the HTM
2.0 standard, the Quick Preview gives you only an approximate i
of how your document will look when viewed with browsers tha
support only HTML 2.0.

You will find a complete HTML reference in WebEdit PRO’s 
online Help. Each tag and attribute is clearly marked with the ea
est HTML version that supports it. In addition, tags that are bro
er-specific (namely the "unofficial" Netscape and Microsoft 
Internet Explorer extensions to HTML) are clearly indicated as 
such.

Menus
When displayed without a document loaded, the menu bar sho
only the File and Help menus. Once you load a document into 
main menu, additional menu options and commands are displa

File Menu

The Quick 
Preview 
window can also 
display tables 
and forms, 
which were 
added in HTML 

Command Description

New Create a new HTML document.

Open Open an existing HTML document on your
hard drive or network.

Open Location Enter the URL of a Web document to inser
into the currently active document in Web-
Edit Pro.
 Getting Started, 2-5
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Edit Menu

Command Description

Insert Select a file to insert into the currently active
document in WebEdit Pro.

Close Close the active document.

Close All Close all open documents.

Save Save any changes you have made to a 
document, overwriting the older version.

Save As Save a document under a different name, 
leaving the original document intact.

Save All Save all open documents.

Export Export HTML document to Unix or 
Macintosh format.

Project Create a new project, or open an existing 
project. WebEdit project files are given the 
.WEP extension.

Print Print the active document.

Print Setup Change printer setup settings.

Exit Exit and close WebEdit Pro.

Recently Used 
Files

Lists the last documents that were opened 
and saved (up to five documents). To open
one of the listed documents, click on its title

Command Description

Undo Undo the last command.

Cut Cut element or text and place it in the 
Clipboard.
2-6, Getting Started

. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 



Insert Menu
 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

ific 
cal 
, and 
ific 

You 

er 

ar 

nt 

d 

t 
Insert Menu

The Insert menu contains most of the commands to insert spec
HTML tags into the current document. Tags are grouped in logi
categories, such as Page Structure tags, Table tags, Headings
so on. When a keyboard shortcut is available for inserting a spec
tag, it is shown next to the tag name on the cascading menus. 
can get detailed information on any HTML element in WebEdit 
PRO’s online Help.

Note
Almost any tag-insertion command can have a button on the us
toolbar (space permitting). See “User Toolbar” on page 2-16 for in-
formation on configuring the toolbar. In addition, the menu toolb
provides one-click access to nearly all of the HTML tags (see 
“Menu Toolbar” on page 2-19).

Copy Copy element or text and place it in the 
Clipboard.

Paste Paste items from the Clipboard at the curre
cursor location.

Delete Delete element or text.

Select All Select all text in the active document.

Find Search for a specific element, attribute or 
text.

Repeat Last Find Find the next occurrence of the text specifie
previously with the Find command.

Replace Find and replace text.

Repeat Last Tag Insert the last-used HTML tag at the curren
insertion point.

Command Description

Page Structure 
Tags

 Examples: Head, Body, Frame
 Getting Started, 2-7
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Command Description

Block Style 
Tags

Examples: Block Quote, Paragraph, Prefor-
matted

Logical Font 
Style Tags

Examples: Abbreviation, Citation, Code

Physical Font 
Style Tags

Examples: Bold, Font, Strong Emphasis

Headings  Heading 1 through Heading 6

Lists and 
Misc Tags

Examples: Horizontal Rule, Ordered List, 
List Item, Comment, Marquee

Form Tags Examples: Form, Input, Select

Table Tags Examples: Table, Table Header, Table Data,
Table Row, Caption

Math Tags Examples: Math Symbols, Math, Array, Su-
perscript

SSI+ Tags Used for adding Server Side Includes. Exam
ples: Include, Exec, ODBC, If, Goto

Object Tags Used for adding objects. Object, Alias, 
Param

Java Tags Used for adding Java applets. Applet, Para

User-Defined 
Tags

Use this command to create, edit, or insert
user-defined tags. For example, you can cr
ate a tag that combines standard tags like 
Bold and Italic, or a tag that inserts an often
used URL (such as your home page URL).

Special CharactersUse this command to insert characters suc
as ampersands, the copyright symbol, frac
tions, and more.

ID/Class/LanguageIn HTML 3.2, most tags within the Body el-
ement can have ID, CLASS and LANG at-
tributes. In general you will not need these.
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Tools Menu

Command Description

Anchor/Link Use this command to insert an anchor or lin
into the HTML document and fill in the de-
sired attributes, such as HREF, NAME.

Image Use this command to insert an image, imag
map, or video clip into the HTML document
and fill in the desired attributes, such as SRC
ALT, ALIGN.

Current Date/TimeUse this command to insert the current day
date, and time into the HTML document.

Hexadecimal 
Color Value

Use this command to select a color and inse
its hexadecimal RGB value into the HTML 
document.

Command Description

Spelling This command launches Web Edit PRO’s 
full-featured spelling checker. You may 
create and use multiple dictionaries, includ
ing dictionaries for languages other than 
American English.

Easy Images This command displays a pick-list of image
files in the default directory, or in any direc-
tory you select. Simply double-click on the 
filename to insert an HTML-formatted refer
ence to the image into the current docume

Easy Links This command displays a pick-list of files in
the default directory, or in any directory you
select. You can display any combination of
text files, image files, HTML files, sound 
files, or All Files. Simply double-click on a 
filename to insert an HTML-formatted refer
ence to the file into the current document.
 Getting Started, 2-9
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Command Description

Extended Chars -> 
Tags

Use this command to convert a special cha
acter or extended character to a tag that 
HTML browsers can interpret.

Tags -> Extended 
Chars

Use this command to convert an HTML tag
for a special character or extended charact
to the character itself.

Multimedia 
Wizard

The Multimedia Wizard generates the 
HTML code to insert video, sound, anima-
tion, and scripts into your HTML documents
using the appropriate syntax for the browse
you specify.

Table of Contents 
Wizard

The Table of Contents Wizard automates th
creation of a Table of Contents page for a 
long HTML document, with various format-
ting options.

Home Page 
Wizard

The Home Page Wizard steps you through
the process of developing a basic home pag
Once the HTML code is generated, you can
easily modify it as you wish.

Tag Checker The Tag Checker lists any tags that are no
supported by a specified browser.

Frame Wizard The graphical Frame Wizard steps you 
through the process of creating and sizing 
frames and assigning the documents to 
display in them, then generates the HTML 
code for you.

Form Builder The Builder prompts you for the information
to display and collect with forms, then gene
ates the HTML code for you.

FTP Upload Use this command to upload HTML docu-
ments and associated files to a directory on
Web server.

Link Validation 
Wizard

The Link Validation Wizard checks all of the
links at a specified URL and reports their sta
tus (OK or broken).
2-10, Getting Started
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View Menu

Options Menu

The Options menu provides access to WebEdit PRO’s configur
tion options.

Command Description

Update Preview Use this command to update the document
the preview window (after making changes
in the document window).

Option Description

Preferences Set defaults for the following options:

Drag and drop behavior - Insert a dragged 
file as tag (such as link or image) or open th
file in a new document window.

Lower case filenames - Use lowercase for 
names of saved files (required for some 
version of Unix).

Word wrap  - Wrap text in document 
windows.

Open new document at startup - Create an 
empty document window each time WebEdit 
PRO is started.

Use syntax highlighting - Display tags in a 
contrasting color.

Toolbar - Select which toolbars to display by
default.
 Getting Started, 2-11
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Preferences 
(cont.)

Browsers - Select which version of available
browsers to launch when the View Docu-
ment with Browser command is used (differ
ent browser versions support different sets o
HTML tags, so you can use this option to tes
your pages in different browser versions).

Configure user toolbar - Opens the user 
toolbar configuration dialog.

Add or Edit Browser - Select which brows-
er to open when the View Document with 
Browser command is used, or add other 
browsers to the list of available browsers.

Color Set default colors for the following:

Document Text - The color of normal text in 
the document windows.

Document Tag - The color of HTML tags in 
the document windows (The "Use syntax 
highlighting" option in the Preference tab 
must be on to display the color you select 
here—see above).

Previewer Text - The color of text in the 
Quick Preview window (where the color has
not been explicitly set using HTML tags).

Previewer HotSpot - The color of link text.

Font Select default fonts and font styles for text in
the document windows and in the Quick 
Preview window.

Files Select a default directory for the WebEdit 
PRO configuration files; these include URLs
that you enter using the URL button found in
various WebEdit PRO dialogs (so that they
can be selected from a pick list).

Also, if you are using Windows NT and 
WebEdit PRO’s File Open dialog displays 
each HTML filename twice, choose the
"HTML only" option in this tab.
2-12, Getting Started
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Option Description

Previewer Set defaults for the following Quick Preview
window behavior:

Display Previewer - If selected, the Quick 
Preview window is displayed by default 
when you start WebEdit PRO.

Full Window Preview - Sets the Quick 
Preview window to display full-screen.

Automatically Update Previewer - If this 
option is on and the Quick Preview window
is displayed, the Quick Preview window 
reflects changes made in the document 
window as they are made (can lag behind 
your typing if large images have to be 
loaded).

Show Pictures - Set this option on if you 
want the Quick Preview window to display 
images specified by the HTML in the docu-
ment window; otherwise a placeholder is 
used instead of the image.

Orientation  - Select how you want the 
screen to be split between the document 
window and the Quick Preview window 
(side by side or above and below).

Carriage Returns Use these check boxes to insert a Carriage
Return and Line Feed before ("Begin") and
or after ("End") the corresponding types of 
HTML tags.

Tags & Paths Set the following defaults for tags and path
used in tags:

Tag case - Choose how you want HTML 
tags to look in your documents.

Pathing - Select how you want file paths to
be entered inside HTML tags. If you select
"Relative to a fixed directory," you need to 
specify that directory under "Fixed directo-
ry" (see below).
 Getting Started, 2-13
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Help Menu

Command Description

Tags & Paths 
(cont.)

Reverse Slashes - If selected, Unix-style 
"forward slashes" are used in paths; other-
wise, DOS "backslashes" are used.

Fixed directory - If you select "Relative to a 
fixed directory" under Pathing, you need to
specify that directory here.

Project WebEdit PRO’s Project Manager keeps trac
of files that belong to a given project. You 
can set the following defaults:

Extended Functionality - When on, the 
Project Manager window visually differenti-
ates files according to the following (this 
slows performance somewhat):

• project file not loaded in WebEdit PRO

• project file that is loaded in WebEdit PRO

• loaded project file that has been modified

• file that could not be found

Close open documents on Project Manag-
er shutdown - When on, exiting Project 
Manager will first save and close all open 
files related to the project.

Stay on top - When on, the Project Manager
window stays on top of all other open win-
dows.

Command Description

Contents Display Help Contents.

Topic Search Search for help on a specific topic.
2-14, Getting Started
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Toolbars
WebEdit PRO has three convenient toolbars: the document tool
user toolbar, and menu toolbar. In addition, the status bar at the
tom of the main window provides useful editing information abo
the currently displayed HTML document

By default, the toolbars are at the top of the window but you can
sition them on the sides or bottom of the window. If you prefer n
to use the toolbars, you can hide them to give yourself a larger 
ument editing area. You can even add or remove buttons on the
toolbar to configure it exactly the way you like. To modify the too
bar display, simply right-click on a toolbar and choose Display 
Toolbar, Align Toolbar, or Configure from the popup menu.

If you forget what a particular toolbar button does, simply place
your mouse cursor over it and wait a second. A small "tooltip" w
dow will appear telling you the function of the button.

Document Toolbar
The document toolbar provides buttons for common tasks relat
to HTML documents. 

Document toolbar

The following provides a brief description of each command av
able from the Document toolbar:

Command Description

Server Side 
Includes

Display SSI+ help.

About WebEdit Displays the WebEdit version number and 
copyright information.
 Getting Started, 2-15
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• New - Open a new, blank document.

• Open  - Open an existing document.

• Save - Save the active document.

• Save All  - Save all open documents.

• Print  - Print the active document.

• Open Project  - Open a WebEdit PRO project file (.WEP), 
which keeps track of the files belonging to a given project.

• Cut  - Remove the highlighted text form the document and pu
in the Windows Clipboard.

• Copy  - Copy the highlighted text to the Windows Clipboard.

• Paste  - Paste the Clipboard contents at the insertion point in
document.

• Delete  - Delete the highlighted text.

• Find  - Find specific text in a document.

• Check Spelling  - Check the spelling in a document.

• Add Minimal HTML  - Automatically insert into a document 
the tags that are required in every HTML document.

• Remove HTML Tags  - Remove all HTML markup from the 
active document.

• View Document with Browser  - Launch the browser 
selected in the Configuration Options (see “Options Menu” on 
page 2-11)

• Quick Preview  - Display the active document in the Quick 
Preview window

• Update Previewer  - Update the Quick Preview window (afte
making changes in the HTML document).

• Help  - Display the main Help page.

User Toolbar
The user toolbar contains buttons for the most commonly enter
HTML tags. You can customize this toolbar with buttons for the
tags you want it to include (to the limit of available space).
2-16, Getting Started
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User toolbar

The following provides brief descriptions of the default tags tha
can be added to a document just by clicking a button on the us
toolbar:

• Bold  - Inserts the <B></B> tags.

• Underlined  - Inserts the <U></U> tags.

• Italic  - Inserts the <I></I> tags.

• Preformatted  - Inserts the <PRE></PRE> tags.

• Unordered List  - Inserts the <UL></UL> tags.

• List Item  - Inserts the <LI></LI> tags.

• Level 1 Heading  - Inserts the <H1></H1> tags.

• Level 2 Heading  - Inserts the <H2></H2> tags.

• HTML - Inserts the <HTML></HTML> tags.

• Head - Inserts the <HEAD></HEAD> tags.

• Body  - Opens a dialog where you can set text and backgrou
colors for the BODY section of the document, and adds the 
<BODY></BODY> tags.

• Title  - Inserts the <TITLE></TITLE> tags.

• Special Characters  - Opens a dialog where you can select 
characters (such as foreign-language characters and math 
symbols) that need special formatting before they can be use
HTML documents—just select the character and WebEdit PR
takes care of the formatting.

• Line Break  - Inserts the <BR>tag.

• Horizontal Rule  - Inserts the <HR> tag.

• Paragraph  - Inserts the <P></P> tags.

• Anchor/Link  - Opens a dialog where you can set attributes o
hyperlink, and adds the <A></A> tags.

• Inline Image  - Opens a dialog where you can set the attribut
of an inline image file, and adds the <IMG> tag.
 Getting Started, 2-17
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You can add or remove buttons on the user toolbar by right-click
on it and choosing Configure from the popup menu. The Toolba
Configuration dialog box contains all of the buttons that WebEd
PRO’s user toolbar supports. To find out which HTML tag a butt
represents, rest the mouse cursor on the button until the tooltip
pears.

User Toolbar Configuration dialog

To add a button to the user toolbar:

1 Right-click on the user toolbar and select Configure from the 
popup menu.

2 In the Toolbar Configuration dialog (see above), click on the ta
that contains the button you want to add.

3 Click on the button you want and drag it to the toolbar.

To remove a button from the toolbar, click on the button on the t
bar and drag it to the configuration dialog box.

Tip
When resizing the main WebEdit PRO window, the user toolbar
may be partially hidden. To see the entire user toolbar, maximize
main window. (The document toolbar and menu toolbar do get 
resized when you resize the main window.)
2-18, Getting Started
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Menu Toolbar

Menu toolbar

The menu toolbar provides quick access to nearly all of the HTM
tags that WebEdit PRO supports through drop-down menus. W
you click on the Page button, for instance, you see a drop-dow
menu containing all of the Page Structure tags. These are also a
able from the Insert menu, but you may find it more convenient a
a while to use the menu toolbar to insert tags.

Status Bar

Status Bar

The status bar at the bottom of the WebEdit PRO window displ
the following information:

• Cursor Position (Line:Column)

• Cursor Mode (Insert or Overwrite)

• Has the file been modified since it was last saved?

• Full path and filename 

• Last status message

Exiting WebEdit PRO
To exit the application, choose the Exit command from the File
menu.

In the next chapter you will learn how to create new HTML 
documents; add tags to create hyperlinks and anchors; add ima
view your documents with a browser; and save your document
 Getting Started, 2-19
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Overview
In this chapter you will learn how to create new HTML documen
use the Home Page Wizard and Minimal HTML features; add ta
to create hyperlinks and anchors; add images; view your docum
with a browser; and save your documents.

Creating a New Document
This section explains how to start a new HTML document. 

To create a new document:

1 Select New from the File menu, or click the New icon on the do
ument toolbar. The New Page dialog displays (see page 3-3).

New Page dialog

2 Select the type of document you want to work on:

• New Blank Page  — Opens a blank document window. Use 
this command if you want to start a new HTML document fro
scratch.

• Home Page Wizard  — Launches the Home Page Wizard. 
This wizard presents you with a sequence of prompts that st
you through the process of creating a basic home page. If yo
are new to HTML, we encourage you to use the Home Page
Wizard first. The Home Page Wizard procedure is described 
the next section.
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• Open Existing Page  — Prompts you to select an HTML 
document. This is equivalent to choosing the Open command
from the File menu.

Using the Home Page Wizard
The best way to "get your feet wet" with HTML is to use WebEd
PRO’s Home Page Wizard. You get the instant gratification of 
seeing your creation immediately, and you also get the source 
HTML document to examine, to keep, or to modify.

The Home Page Wizard presents a series of windows with prom
for text and names of files that you want to appear in your hom
page. At any time you may go back to previous steps and chan
your entries by clicking the Previous button.

To start the Home Page Wizard:

1 Select New from the File menu, or click the New icon on the 
document toolbar. The New Page dialog displays (see page 3-3).

2 Select Home Page Wizard, then click OK.

3 The initial Home Page Wizard window displays, with a brief 
explanation of how it works. When you have read the text, click
Next. The Select a Title window displays (see page 3-4).

Home Page Wizard - Select a Title window
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4 Enter a title for your page, and optionally, a subheading. By 
default, a horizontal rule is placed after the subheading, and the 
title and subheading are centered on the page. If you want to t
either of these options off, clear the corresponding check box. 
When done, click Next.

5 The Background window displays.

Home Page Wizard - Background window

6 If you want your home page to have a colored background, se
the Colored Background option, then click Select to choose a c
in the Color dialog. (The default color is white.) If you have an 
image file that you want to use as the background, select the Im
Background option and enter the name of the image file in the 
space provided. (If the image is smaller than the size of the 
browser window, the image will be tiled to fill the browser 
window.) When done, click Next.

7 The Picture window displays.
 Creating New Documents, 3-5
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Home Page Wizard - Picture window

8 If you want to include an image on your page, select the Includ
Picture check box and enter the name of the image file in the sp
provided. You may enter a caption for the picture by selecting t
Include a Caption check box and entering the caption in the sp
provided. If you want the picture to be centered, select the Cen
Picture on Page check box. When done, click Next.

9 The Paragraph window displays.

Home Page Wizard - Paragraph window
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To enter the text that you want on your page, select the Includ
Paragraph check box and type the text you want. When done, c
Next.

10 The Links window displays.

Home Page Wizard -Links window

If you want to include a link to another Web site on your home 
page, select the Include Site Link check box. In the Site Locati
text entry box, enter the URL of the site you want to link to. In t
Site Description text entry box, enter a brief description or title f
the site you are linking to. When done, click Next.

11 The Page Links window displays.
 Creating New Documents, 3-7
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Home Page Wizard - Page Links window

If you want to include a link to another HTML document that yo
have created, select the Include Page Link check box and click
Locate to select the HTML document to which you want to link.
The document’s filename appears in the Page Filename text e
box when you return to this window. In the Highlighted Name o
Link text entry box, enter the text you want to appear on your p
as the underlined link to the other document. When done, click
Next.

12 The Contact Information window displays.

Home Page Wizard - Contact Information window
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This is where you enter your name and e-mail address, so tha
people can send you e-mail directly from your home page. To 
include your name and e-mail address, select the Include Cont
Information check box and enter your name and e-mail addres
the space provided. When done, click Next.

13 The Finished window displays. One more click and you are do
Click Next. WebEdit PRO generates the HTML for your home 
page and displays the source file in a document window. To se
what your home page will look like in a browser window, click th
Quick Preview toolbar button.

14 Save the new document.

Congratulations! You are on your way to becoming a Webmast
As you learn more about HTML, you can fine-time the wizard-
generated document, add text, lists.

Tip
If you plan to be creating many pages similar to your home pag
you can start with the wizard-generated document, customize i
needed, and save it with a different filename; you do not need t
re-invent the wheel each time you want to create another page!

Using the Minimal HTML Feature
WebEdit Pro’s Minimal HTML feature instantly inserts into a ne
blank document the essential tags required in every HTML doc
ment. You can also change and extend what the Minimal HTML
feature inserts. The Minimal HTML feature is available only if a
new blank document is the current document.

To insert minimal HTML tags:

1 Open a new blank document.

2 Click the Minimal HTML button on the document toolbar.
 Creating New Documents, 3-9
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The default tags inserted by the Minimal HTML button are the 
following:

<HTML>

<HEAD>
<TITLE>Page Title</TITLE>
</HEAD>

<BODY>
<H1>First Heading</H1>
...Add body text here...
<HR>
</BODY>

</HTML>

You can modify what the Minimal HTML button inserts simply b
editing the minimal.html  file in the WebEdit program directory.

Adding Tags to Text
It is often more efficient to enter, organize, and edit the text cont
of a document and then format the text and the page using HTM
tags. When you want to insert HTML tags around text in a docu
ment, the general procedure is to select the text, then select th
you want to place around the text.

To add a tag to text in the document:

1 Highlight the text you want to tag.

2 Select the tag you want to apply to the text.

You can select tags from the Insert menu, from the menu toolba
from the user toolbar. Many common tags also have keyboard s
cuts. In addition, many of the most frequently used tags are als
included on a pop-up menu that appears when you right-click on
document window.

For example, to designate text as a Level 1 Heading, you can u
any of the following methods (once the text for the heading has b
highlighted):
3-10, Creating New Documents
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• Choose Headings from the Insert menu, then select Heading

• Click Heading on the menu toolbar, then select Heading 1.

• Use the keyboard shortcut Shift+Ctrl+1.

• Click the Level 1heading button on the user toolbar.

• Right-click in the document window and select Heading 1.

Each of the above actions opens the Heading dialog, where you
assign various attributes to the heading.

Tip
If you find that you frequently use certain tags in combination (f
example, Bold and Italic), or if you are re-using certain text in ma
documents, you can create a user-defined tag that will automatic
insert multiple tags around the text you highlight or insert the co
tents of a file at the insertion point (see Chapter 8, "Special Cha
ters and Custom Tags.")

Adding Hyperlinks
Nearly all HTML documents contain "hyperlinks" (hypertext 
links), which are usually referred to simply as "links." Links are t
hallmark of the World Wide Web and of intranets, enabling users
"jump" from one document to another, or from one section of a
document to a different section in the same document.

When you view HTML documents in a browser, links are usual
indicated by underlined text; usually the underlined text is dis-
played in a contrasting color.

To add a hyperlink to a different document:

1 In the document window, select or enter the text that you want
be underlined on the page (that is, the text that you want reade
click on).

Note
You can also use an image as the link instead of text. See “Using 
Images as Hyperlinks” on page 3-21.

2 Click the Link button in the user toolbar. The Anchor/Link dialo
displays.
 Creating New Documents, 3-11
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Anchor/Link dialog

3 Enter the following information as desired. Only HREF is 
required. 

Note
Some of the fields in the Anchor/Link dialog are used only whe
creating <LINK> elements; these should be ignored when crea
anchor-type hyperlinks, as in this procedure. (Most browsers 
ignore <LINK> elements.)

Field Description

HREF Enter the URL for the document you want 
the link to open. Optionally you can click the
URL button to browse for the URL or file.

Target "Target" is the name of the window in which
you want the linked document to appear. If
the window is not already open, the browse
will open and name a new window for you. If
you are using a window with frames and th
frames are named, you can use this field to
make the linked document display in a 
specific frame by entering the frame name 
here.
3-12, Creating New Documents
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4 Click Anchor. Do not use the Link button in this procedure (the 
Anchor button inserts the <A> and </A> tags that you want, 
whereas the Link button would insert the <LINK> tag.)

The inserted HTML will look like this:

<A HREF=" URL">Text to be underlined </A>

Field Description

Name If you are defining an anchor that other link
can point to, enter the name you want to us
for this anchor.

Title For use with the <\LINK> tag. The Title 
describes the linked document, for informa
tion only (not displayed).

Message Digest Specifies a cryptographic checksum for the
linked document designated by the HREF 
attribute, to insure its integrity. It is used 
when you want to be sure that users link to
the document that you intended, and that it
has not been modified in any way.

Rel For use with the <LINK> tag. The drop-
down list contains the available relationship
from the current document to the linked 
document.

Rev For use with the <LINK> tag. The drop-
down list contains the available relationship
from the linked document to the current 
document.

URN You may enter the Uniform Resource Nam
for the linked document.

Shape If you are creating a "clickable hot spot" link
for a graphic, select the shape of the hot sp
In the HTML document you will need to fill 
in the needed coordinates represented by x
r, w, h, etc.
 Creating New Documents, 3-13
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Using Easy Links
The Easy Links feature allows you to add a hyperlink to a spec
file simply by picking the file from a list and dragging it into the 
HTML document.

To use Easy Links:

1 In the HTML document, place the insertion point where you wa
the link to be inserted.

2 Choose Easy Links from the Tools menu. The Easy Links dialo
displays.

Easy Links dialog

3 Select the types of file you want to appear in the file list (HTML
only, All Files, HTML and Sound files, and so on) by clicking th
applicable check boxes in the lower right section of the dialog.

4 Use the drive selection drop-down list and the directory tree on
right side of the dialog to navigate to the location of the file you
want to create a link to. The files in that directory that match th
types of files you selected in step 3 are listed on the left side of
dialog.

5 Drag and drop the file you want into the HTML document.
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For example, if you drag a file named index.html from a local direc-
tory named c:\wwwroot into the HTML document, the following 
HTML tags are inserted:

<A HREF="c:/wwwroot/index.html"></A>

Be sure to remove or adjust the path information, if necessary, 
to avoid the problem of browsers not being able to locate the fi
(see “"Relative Addressing"” on page 3-17).

Using Anchors
Usually a link to another document displays the top of the targe
document in the browser window. However, you can also creat
link to any location in a document. To jump to some location in 
document other than the top requires you to define the places t
reader can jump to; these are called anchors. Once anchors are 
defined, you can create a link to an anchor, just as you create a
to another document. Anchors can also be used to create links 
one section of a document to another section of the same docum

An anchor has the following structure:

<A NAME=anchorname ></A>

Note
If the anchor Name is more than one word, use double quotatio
marks at the beginning and end.

A link to an anchor in the same document has the following 
structure:

<A HREF=#anchorname >This is underlined </A>

A link to an anchor in a different document has the following str
ture, where URL is the URL of the document containing the ancho

<A HREF=URL#anchorname >This is underlined </A>

To create an anchor:

1 In the document window, select the text that you want readers
see at the top of the browser window when they click on a link 
this anchor. Typically you would select a section heading.
 Creating New Documents, 3-15
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2 Click the Link button in the user toolbar. The Anchor/Link dialo
displays.

3 In the NAME field, enter a name for the anchor.

4 Click Anchor. Do not use the Link button in this procedure (the 
Anchor button inserts the <A> and </A> tags that you want, 
whereas the Link button would insert the <LINK> tag.)

To create a link to an anchor:

1 Put the insertion point where you want the link to appear in the
HTML document.

2 Click the Link button in the user toolbar. The Anchor/Link dialo
displays.

3 In the HREF field, enter # and the Name of the anchor you wan
link to, with no spaces. If the anchor is in a different document,
enter the URL of the document followed by # and the anchor 
Name, with no spaces.

For example, to create a link to an anchor named #hereiam in a 
document named findme.html (in the same directory as the curren
document), you would enter findme.html#hereiam in the HREF 
field.

4 Click Anchor. Do not use the Link button in this procedure (the 
Anchor button inserts the <A> and </A> tags that you want, 
whereas the Link button would insert the <LINK> tag.)

Adding Images
You can add image files to your document from your local drive
a Web page. The most popular formats for image files in HTML
documents are GIF and JPG (or JPEG). However, TIF and ART
files can also be used.

A typical image tag might look like this:

<IMG SRC="myphoto.gif">

<IMG> is actually the tag, while SRC= indicates the source file th
contains the image.
3-16, Creating New Documents
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"Relative Addressing"

If you add an image tag to a page, but the image does not appe
your browser, it is most likely because the browser cannot find 
image file. The following applies to what you enter as the SRC 
tribute of an image (see page 3-18). It applies as well to what you 
enter as the HREF attribute of a link ( see page 3-12).

Although you can use a pathname in an image tag, it is not rec
mended. Consider the following example:

<IMG SRC="c:\images\myimage.gif">

This will work fine as long as the page is on your local hard driv
but as soon as you move the page to your Internet server, no bro
will be able to locate the image file. Similarly, the following exam
ple will work adequately on an Internet server, but not on your lo
hard drive:

<IMG SRC="http://www.myserver.com/
myimage.gif">

The solution to this is to always use "relative addressing" in you
references to files: Whenever possible, put the image files in th
same directory as the HTML file. Then you need include only th
filename after such attributes as HREF= and SRC=.

If it is not acceptable to put image files in the same directory as
HTML file, put them in a subdirectory of the directory that contai
your HTML file. Then the address of the image file can be relat
to the address of the HTML document itself. For example, the 
following image tag will work fine on both your local hard drive 
and your Internet server, as long as the image file is in the sam
subdirectory in both locations:

<IMG SRC="/images/myimage.gif">

To add an image to a document:

1 Place the insertion point in the HTML document where you wa
the image to appear.

2 Click the Image button on the user toolbar, or choose Image fr
the Insert menu. The Image dialog displays.
 Creating New Documents, 3-17
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3  Enter the following information, as applicable:

Field Description

Src Enter the filename of the image you want to
put in the document. You can use the URL 
button to browse for the file.

Link To If you want the image to be a link to anothe
document, enter the filename of the docu-
ment here. You can use the URL button to 
browse for the file.

LowSrc (Netscape)If you have a smaller (lower-reso
lution) image file that you want to use as a 
link to the larger image file, enter the filena
me of the smaller file here.
3-18, Creating New Documents
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Field Description

X-AltSrc To insert an image that uses the Johnson-
Grace ART image compression standard, 
enter the filename of the image here.

Alt text Enter the text that you want to appear in plac
of a graphic whenever a user has turned o
graphic imaging, or if a browser is being use
that cannot display graphics. This allows u
ers to see that a graphic exists on the page
even though the graphic itself does not dis
play.

The text you enter here is added to the ALT
attribute of the image tag.

Alignment This option determines how the image align
with text elements that are on the same line
the page. Select an option from the drop-
down list. (See "Image" in the online Help 
for an explanation of each option.)

Clear Text normally wraps around left-aligned and
right-aligned images. However, with this op
tion you can force text to start on the first 
"clear" line below an image on the left 
margin (LEFT), on the right margin 
(RIGHT), or on either margin (ALL).

HSpace If you want to add blank space to the left an
right of the image, enter the amount of spac
here (in pixels).

VSpace If you want to add blank space above and be-
low the image, enter the amount of space 
here (in pixels).

Width Normally a browser calculates the dimen-
sions of a image before displaying it. If you
specify the width of the image here, (in pix-
els), the viewer of the document will not hav
to wait for the image’s size to be calculated

Height As with the Width attribute, you can specify
the height of the image (in pixels).
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Field Description

Border If you want to change the default size of the
colored border around the image, enter the
desired width (in pixels). 

Tip:  If the image is being used as a link, do
not make the border 0 units.

Units This optional attribute specifies the units fo
the width and height attributes. It is either 
pixels (the default) or ens (half the point 
size).

Use Mapping If you are inserting an image map created 
with WebStudio’s Web Map, select this 
check box. (You can also create an image 
map in WebEdit PRO. See "Map Builder" 
below.)

Map Location If you selected the Use Mapping check box
enter the location of the image map.

Map Builder You can create an image map in WebEdit 
PRO by clicking Map Builder. Map Builder 
is similar to WebStudio’s Web Map. Howev
er, Map Builder only lets you create rectan-
gular clickable areas. Web Map lets you 
create different shapes as clickable areas.

DynSrc Specifies the address of a video clip or 
VRML world. You can specify an image file 
that will display if the viewer’s browser does
not support inline video. (See "AVI Videos" 
in the online Help for examples.)

Start For a video clip, you can specify the action
that starts the playback of the file: FILE-
OPEN means start playing as soon as the f
is done opening (default). MOUSEOVER 
means start playing when the user moves th
mouse cursor over the clip. (See "AVI Vid-
eos" in the online Help for examples.)
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Tip
As a courtesy to your users, you should indicate the size of an im
file, sound file, or video file so users are forewarned should the
decide to display, play, or download it.

Using Images as Hyperlinks

You can use an image as a link instead of text, or in addition to t
This is accomplished by nesting the image tag inside the link ta
In the following example, the "target" file is an AVI file, and the 
link (what the user clicks on to play the AVI file) is a GIF file.

<A HREF="greeting.avi"><IMG SRC="myphoto
.gif"></A>

Using Easy Images
The Easy Images feature allows you to add an image file simply
picking the file from a list and dragging it into the HTML documen

To use Easy Images:

1 In the HTML document, place the insertion point where you wa
the image to be inserted.

Field Description

Show Controls Select this option if you want playback 
controls (Start, Stop, etc.) to de displayed 
with the video.

Loop Specifies how many times a video clip will 
loop when activated. (See "AVI Videos" in 
the online Help for examples.)

Infinite Loop If this option is selected, the video clip will 
loop until stopped by the viewer.

Loop Delay If you have selected a Loop attribute, you ca
specify the number of seconds to wait 
between loops.
 Creating New Documents, 3-21
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 



WebEdit PRO User’s Guide
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

dia-

 the 
 
are 

em 
2 Choose Easy Images from the Tools menu. The Easy Images 
log displays.

Easy Images dialog

3 Use the drive selection drop-down list and the directory tree on
right side of the dialog to navigate to the location of the file you
want to add to your document. The image files in that directory 
listed on the left side of the dialog.

Note
Only GIF, JPG, and JPEG files are displayed.

4 Drag and drop the file you want into the HTML document.

For example, if you drag a file named myphoto.gif from a local 
directory named c:\wwwroot into the HTML document, the follow-
ing link is inserted:

<IMG SRC="c:\wwwroot\myphoto.gif">

You may need to adjust the path information, to avoid the probl
of browsers not being able to locate the file (see “"Relative Address-
ing"” on page 3-17).
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Viewing Documents with a Browser
In addition to having a built-in quick previewer, WebEdit PRO al
allows you to use an external browser such as Netscape Navig
Microsoft Internet Explorer, or Mosaic to view your pages.

To launch an external browser from WebEdit PRO:

1 Select the View Document with Browser button on the docume
toolbar.

2 The first time you select this button, WebEdit PRO displays a 
dialog asking you to select a browser to use. Click Add.

3 Enter the name of the browser and its full path and filename (u
the Browse button if necessary). Click OK.

You can change your default external browser or add additiona
browsers by selecting Configure from the Options menu and se
ing the Add or Edit Browsers button on the Preferences tab.

Once you have chosen a browser, you can launch that browse
any time by clicking on the View Document with Browser button
Then use the browser’s File Open command to view your docum

Saving Your Work
You should save your work periodically as you use WebEdit PR

To save the current document:

• Choose Save from the File menu, or press Ctrl-S, or click the
Save button on the document toolbar.

You can tell if the current document has been modified since the
time it was saved by looking at the status bar at the bottom of t
document. If your document has been edited since it was last sa
the status bar will read "Modified." If the document has not bee
edited since the last save, it will read "Not Modified".
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To save all open documents at once:

• Choose Save All from the File menu, or press Ctrl-Shift-S, or
click on the Save All button on the document toolbar.

In the next chapter you will learn how to use WebEdit PRO’s 
powerful tools for creating forms, tables, frames, and more.
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Overview 
WebEdit PRO’s tools and wizards make short work of the most 
advanced page design. Probably the most valuable assistance
can get from an HTML authoring tool is automatic generation —
based on your WYSIWYG input—of the more complex HTML 
structures, such as tables, forms, and frames, while still providi
you with final control of the HTML markup. Once you have put 
Web-
Edit PRO’s tools and wizards through their paces, you will wond
how you ever did without them.

In this chapter you will learn how to use WebEdit PRO’s powerf
and time-saving tools:

• Table Builder

• Form Builder

• Frame Wizard

• Table of Contents Wizard

• Tag Checker

• Link Validation Wizard

• FTP Upload Facility

Using the Table Builder
WebEdit PRO’s Table Builder allows you to enter cell contents a
headers in an empty grid; select cell background color, text alig
ment, border width, and other attributes; then generate all of th
HTML code with a single click.

Tables are supported only in browsers that can display HTML 2
or later. Basic tables consist of the following elements:

• Caption - Table title

• Headers - Column titles

• Rows

• Data - Cell contents
 WebEdit PRO Tools, 4-3
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Additional table tags have been introduced since HTML 2.0 wa
officially approved. Keep in mind that not all version of existing 
browsers will be able to display all of the available table tags. B
sure to use the Tag Checker and also to view your documents 
the browsers you intend to support.

To create a table:

1 Choose Table Tags from the Insert Menu, then select Table 
Builder. The Table Builder dialog window displays.

Table Builder window

Tip
If you want to start over at any time during the following proce-
dure, you can click Clear to clear the Table Builder entries.

2 Enter the cell contents in the grid at the top of the dialog.

3 If you want the table to be les than the full width of the displaye
page, select a percentage from the Table drop-down list. The ta
will be resized automatically by a browser to fill that percentage
the width of the document window in the browser.
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4 Select the alignment of the table from the Table Align drop-dow
list. (Refer to the HTML Reference in online Help for description
of each of the options.)

5 Enter a caption (title) for the table in the Caption text entry box

6 From the Caption Alignment drop-down list select Top or Botto
to display the table’s caption above or below the table, respec-
tively.

7  The Border option is on by default. Enter the desired border wi
in the Border Width text entry box. The unit of measurement is 
pixels. If you want a borderless table, clear the Border check b

8 If you want to add additional space around the contents of cell
enter a number in the CellPadding text entry box. The unit of 
measurement is pixels.

9 If you want to add additional space between the cells, enter a 
number in the CellSpace text entry box. The unit of measurem
is pixels.

10 Select the background color of the cells from the Cell Color dro
down list. Or click on the Color button and select a color from t
standard Windows Color dialog.

11 When done, click Generate Table. The HTML code is inserted 
the current document at the location of the insertion point. Click
the Preview toolbar button to preview how the table is likely to 
appear when viewed in a browser. 

Not all browsers support all table tags and attributes, so be sur
check out the table in each of the browsers that you want to be 
to display your document.

Importing and Exporting Tables
The WebEdit PRO Table Builder enables you to import and exp
tables, using the Import and Export buttons. Use the Import/Exp
Field Separator to specify the character (comma, tab, etc.) that
want to use to separate the fields (cells) in tables that you are g
to export, or to specify the field separator to look for in imported
bles. The default file type for exported and imported tables is co
ma-delimited (.CSV), but you can change the file type to text 
(.TXT) if necessary.
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Using the Form Builder
Forms enable people who are viewing your document to send in
mation back to your Web server, be it as simple as name and add
information or as complex as an order for merchandise. Typica
forms include text entry boxes, check boxes, radio buttons, and
Submit button to send the information back to your server. 

WebEdit Form Builder simplifies the creation of Web forms by 
consolidating all of the components of a form into a single, easy
use tool. With the Form Builder, you can quickly add buttons, te
fields, lists, checkboxes, etc., and let WebEdit PRO write the 
HTML for you. You can even try out the form and see the inform
tion that is sent when the Submit button is pressed.

Forms are created in two stages in Form Builder: first you ident
the required Action and Method for the form (explained below),
then you select and arrange the elements of the form.

To launch the Form Builder:

1 Select Form Builder from the Tools menu. After a moment, the
Form dialog displays.

Form dialog

Note
Throughout the form builder, required fields are colored yellow.
Optional fields are white.
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2 Enter the form Action. An Action is required for every form. The
Action specifies where the contents of the form are sent when 
Submit button is clicked. 

For example, the Action can be the URL of a script on your we
server or a "mailto:" URL (for example, mailto:support@luck-
man.com). If you use mailto: followed by your email address, th
contents of the form will be mailed to you when the user clicks 
submit button. If you have created a CGI script to handle the fo
data submitted by the user and to return a message to the use
enter the URL of the script in the Action field.

3 Select the form Method. The Method specifies how the conten
are sent. The Post method is almost always used. Do not change 
this unless you know what you are doing and you have a good
reason. For more information about the Action and Method 
attributes, look in the WebEdit Help file under "Form."

4 When done, click OK. The WebEdit Form Builder window 
displays.

WebEdit Form Builder window (new form)

The toolbar across the top gives you quick access to the variou
ements you can add to a form. A tooltip description for each toolbar 
button appears when you rest the mouse pointer on it for a sec

5 Click on the toolbar button corresponding to the element you w
to add and fill in the element’s properties in the dialog that 
displays. 
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Once you close the properties dialog, the element is added bo
the end of the list on the left side of the Form Builder window a
to the form preview on the right side of the Form Builder windo
(see “WebEdit Form Builder window (form in progress)” on pag
4-9).

Most elements in a form will have three parts:

• Caption  — The caption of an element is the text that users s
next to or above the element. For example, if you want a Firs
Name text entry field, you might label it First Name. Use the 
Document Text element to enter the caption for an element 
before you choose the element itself.

• Name — The Name of an element can be the same as the 
caption, but it does not have to be. The element’s Name is lik
field name in a database. Users do not see the Name; it is ju
way to identify the element to the browser.

• Value  — Just as an element’s Name is like the name of a da
base field, so the element’s Value is like the contents of a da
base field. For text fields and text areas, you normally do not 
in a Value; what the user enters becomes the value. For exam
if a user enters "Florence" in a text field named firstname, the
value of firstname becomes "Florence," and that is what is se
back to the server.

Note

For text entry boxes you can specify the default size—number 
characters—of the text box (Size) and the maximum number of
characters (Max Length) that users can enter in the text box.

For check boxes and radio buttons, users do not enter anything
you should enter a Value for each one; when a radio button or ch
box is selected, the browser can tell which one is selected and s
its Value back to the server.

The best way to get the feel of how the Name and Value proper
work for various kinds of elements is to experiment. If the eleme
does not look the way you want it to, double-click on it in the lis
and edit the properties. Also, you will be able to edit the HTML ge
erated by the Form Builder in the document window after you e
the Form Builder.
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As shown in the next figure, the list on the left of the window 
shows you a list of the elements you have added to your docum
New elements are added to the bottom of the list. You can mov
elements around in your document, edit them, and delete them

The display on the right-hand side of the window shows you th
form as it will appear in a browser. You can even fill in your form
and click the Submit button to see the information will be sent.

WebEdit Form Builder window (form in progress)

• To move an element, click on it and drag it to a new location 
the list. 

• To edit the element’s properties, double-click on it in the list.

• To delete an element, select it in the list and click the Delete 
ton on the toolbar.

For more information on HTML form tags, look in the WebEdit 
Help file under the topic "Form Tags".

Using the Frame Wizard
Frames are a relatively recent addition to HTML, and not all bro
ers support them. What frames add to HTML is the ability to divi
the browser’s display window into several areas, or frames, eac
which can act like a little window, displaying separate documen
 WebEdit PRO Tools, 4-9
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The Frame Wizard helps you create frames-based Web pages 
quickly without having to write the Frame and FrameSet tags yo
self. You simply point and click to define where you want your 
frames, specify which document each frame will contain, and th
Frame Wizard does the rest.

Before you launch the Frame Wizard, you might want to make so
designs on paper to get an idea of how many frames you want to
what you want to be displayed in each one, and the approxima
boundaries of each frame.

The Frame Wizard can insert the HTML it writes into the curren
document or it can create a new document. If you want it to ins
its HTML into the current document, make sure you position ins
tion point in the document before launching the Frame Wizard.

To create frames:

1 Choose Frame Wizard from the Tools menu. The opening Fram
Wizard window displays, with a brief explanation of how to use
the Next and Back buttons. 

2 Click Next. The second Frame Wizard window displays. In this
window you define how you wish to divide up the browser 
window into horizontal and vertical frames.

Frame Wizard window #2
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3 To divide an area horizontally, click on the horizontal bar button
and then click in the window area on the left where you wish to
place the frame. Similarly, to divide an area vertically, click on the
vertical bar button and then click in the window area. You can 
move your frames by clicking and dragging them. If you need t
start over, simply click the Clear button.

4 Once you have placed all your frames, click Next. The third Fra
Wizard window displays.

 Frame Wizard window #3

5 The next step is to specify an HTML document, frame name an
other properties for each frame. To enter the information for a 
frame, simply click on the frame area on the left and then fill ou
the information on the right.

Important!
You should complete all information for each frame before pro-
ceeding to the next step.

Command Description

Source The name of the HTML document to be 
displayed in the selected frame.
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6 When done, click Next. The last Frame Wizard window display

7 Choose whether to insert the HTML for the frames into the curr
document or create a new document, and click Finish. WebEdi
automatically writes the HTML.

Note
The Frame Wizard uses percentages for defining the height an
width of individual frames (for example, <FRAMESET 
ROWS="22%,78%">). If you need your frames to be a specific 
number of pixels wide or high, you may modify the FrameSet ta
accordingly. For more information, look in the WebEdit Help file 
under the topic "FrameSet."

Command Description

Name Enter a name for the selected frame. A 
frame's name can be referenced by the Targ
attribute of an Anchor tag—for example, <A
HREF="products.html" 
TARGET="main">

Margin Width If you need to control the margins of a frame
enter the desired margin width, in pixels. 
This option can be ignored. By default, all 
frames default to letting the browser decide
on an appropriate margin width. 

Margin Height If you need to control the margins of a frame
enter the desired margin height, in pixels. 
This option can be ignored. By default, all 
frames default to letting the browser decide
on an appropriate margin width. 

Scrolling This setting determines if the frame should
have a scrollbar or not. Yes results in scroll-
bars always being visible in that frame. No 
results in scrollbars never being visible. Auto 
instructs the browser to decide whether 
scrollbars are needed and place them whe
necessary. The default value is Auto.

Allow Resize Check this check box if you want users to b
able to change the height or width of the 
frame in their browsers.
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Using the Table of Contents Wizard
Many HTML documents are organized into sections by using he
ing tags such as <H1>, <H2>, etc. The Table of Contents Wizar
can read such documents and automatically generate a table o
hyperlinks to each section of the document. You can add this tab
to the beginning of your HTML document to make it easy for use
to jump to any location in the document itself.

The Table of Contents Wizard creates anchors at the locations o
headings, then creates links to the anchors. Finally the wizard 
arranges the links in a list.

Note
The Table of Contents Wizard does not work on all pages, only o
that include heading tags.

To create a table of contents for a document:

1 Make sure that the active window contains the document for 
which you are creating a table of contents.

2 Choose Table of Contents Wizard from the Tools menu. The 
initial wizard page displays, with a brief explanation of what it 
does.

3 Click Next. The list of headings in the current document is 
displayed.

4 Click Next.

5 Select the Levels radio button for the deepest level of heading yo
want to include in the table of contents.

6 Click Next.

7 Select the Numbering system to add option that you want to use,
or select None to use no numbers or bullets.

8 Click Next.

9 Click Finish. The table of contents HTML is inserted at the beg
ning of the current document. The beginning and end of the tab
of contents are marked with comments so you can easily selec
and put it wherever you like in your document.
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Using the Multimedia Wizard
WebEdit PRO's Multimedia Wizard lets you create pages with 
multimedia content such as video and audio, plus visual enhan
ments such as color schemes, scrolling marquees, and even co
mon JavaScript applets. You select the files, and WebEdit gener
the HTML you need to include them in your documents.

The Multimedia Wizard automatically starts a new document ea
time you use it, to store the HTML it generates. If you already ha
a document started, you can cut and paste from the wizard-gen
ed document into your document.

To use the MultiMedia Wizard:

1 Choose Multimedia Wizard form the Tools menu.

2 The two most popular browsers—Netscape Navigator and 
Microsoft Internet Explorer—use slightly different syntax to 
embed some multimedia objects. On the first page of the Multim
dia Wizard, select whether you want the wizard to generate HTM
for Navigator or Internet Explorer and click the Next button.

3 The second Multimedia Wizard window uses a tabbed-noteboo
interface to let you quickly choose the multimedia features you
wish to add to your page.

Multimedia Wizard window
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4 Click on one of the tabs for the features you want.

5 Navigate to and select the file you want to use, and make sure
check box in the lower-right corner is selected.

For example, if you want to add a video to your document, ma
sure the Use Video check box is checked on the Video page. T
check box will be checked automatically when you select an AV
video file. If you change your mind and decide not to use the 
video, simply clear the Use Video box. You can tell at a glance
which types of files will have HTML generated for them becaus
their tabs have a check mark.

Note
Not all browsers support all multimedia files. For example, curre
ly only Internet Explorer supports the Marquee tag.

6 When you are done selecting the multimedia features you wish
use, click Next.

7 Click Finish. The wizard writes the HTML for you and puts it in 
new document in WebEdit PRO. The HTML for each type of 
multimedia feature is clearly commented.

Using the Tag Checker
The WebEdit Tag Checker tests the current document for comp
ance with several different levels of HTML and with Netscape 
Navigator and Microsoft Internet Explorer extensions.

To check HTML tags:

1 Make sure the HTML document you wish to check is the curre
document.

2 Choose Tag Checker from the Tools menu. The WebEdit HTM
Tag Checker window displays.
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WEB Edit HTML Tag Checker window

3 Click whichever Check for compliance with option is appropri-
ate, to select an HTML level.

Note
You can repeat the tag checking procedure with different comp
ance options to locate non-complaint tags for different levels o
HTML and for different browsers.

4 Click Check. The Tag Checker will report any tags or attributes
that are not valid in the specified HTML level or browser.

5 To correct an error found by the Tag Checker, simply double cl
on the error message in the Tag Checker's list to move the ins
tion point in the current document to the beginning of the invali
line. 

Tip
You may edit the line without closing the Tag Checker. This allo
you to correct all errors without having to repeatedly open and cl
the Tag Checker.

Note
The Tag Checker is a useful and powerful tool, but it is not a co
plete HTML syntax checker. It will not report some errors such 
missing end tags or tags in invalid locations (e.g., a list item ins
of the document head, etc.). A list of free web-based HTML vali
tion services and syntax checkers is available at the following s

1. Select one of 
the compliance 
options.

2. Click Check.

3. Double-click
an error message 
to go to the place 
in the HTML docu-
ment where the 
error was detected.
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Using the Link Validation Wizard
The Web is a growing and changing environment where servers
pages often move or disappear. To help ensure your hyperlinks
correct and that the pages they point to are still valid, WebEdit P
includes a Link Validation Wizard.

The Link Validation Wizard can look at any document on the We
examine it for inline images and hyperlinks to other pages, and t
test to ensure that these images and pages exist.

You must have an open Internet connection in order to validate
links in a Web document. If you have not connected to the Inter
before starting the following procedure, the Link Validation Wiza
will launch your dialer program to establish a connection at the
appropriate time.

To validate links:

1 Choose Link Validation Wizard from the Tools menu. The open
ing screen displays a brief explanation of what it does.

2 Click Next. The Enter Document URL dialog displays.

3 Enter the URL of the document whose links you wish to check.
You may optionally click the URL button to construct the URL b
selecting a protocol and entering server, port (if necessary), an
filename information. By default the Link Validation Wizard wait
30 seconds for each link to be found before "timing out." You m
decrease or increase the number of second, if desired.

Note
The Link Validation Wizard will not check links in a document o
your hard drive. You must specify a file on the Web. You should
use the full URL form (for example, http://www.server.com/path
file.html).

4 Click Next. If you do not have an open connection to the Intern
the wizard starts your dialer program to establish a connection
Once the document’s URL is found, the wizard generates a list
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all of the links in the specified document then displays the Cho
Links to Validate dialog.

5 To validate only one or more selected links, click the Validate 
Selected Links radio button and click on the links you wish to 
validate.

6 Click Next to validate the links. When the validation is complet
the Validation Results dialog displays.

On the left side of the list is the link that was checked, and on 
right side is the status of the link.

Uploading Files to a Web Server
Normally as you create and edit HTML files, you save them on y
computer's hard drive. When you are ready to make them avail
on the Web, you can transfer them via FTP (file transfer protoco
to a remote server. You need to transfer not only the HTML files 
also any other files (such as graphics, sound, and video files) t
are used in your Web pages.

WebEdit PRO includes an integrated FTP upload tool that lets y
upload your files from within the program. The FTP upload tool c
keep track of multiple FTP servers, and automatically selects a
currently open documents for uploading.

To open the FTP Upload tool:

1 Choose FTP Upload from the Tools menu. the FTP Upload dia
displays.

2 Click on the Server tab.
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FTP Upload dialog - Server information

3 The first time you use the FTP upload tool, you need to define 
server where you wish to send your files. Click New. The New 
Server Name dialog displays.

4 Enter a name for the server (anything you like) and click OK.

5 Enter the following information in the other fields:

Field Description

Server Enter the domain name or IP address of th
server to which you want to upload files.

Port Leave this as is (21), unless your ISP has to
you that FTP services use a different port.

Directory on FTP 
Server

Enter the complete path to the directory 
where your files are to be stored.

Important!
Do not put a "/" (forward slash) at the be-
ginning of the directory path.
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6 When done, click Save. The next time you use the FTP upload
tool, you should not need to use the Server tab.

Note
If you upload files to more than one FTP server, or to more tha
one location on the same FTP server, you can add as many se
as you like. Simply click on the New button and give each one 
unique name.

7 Click the Files to Upload tab to check the list of files.

When you launch the FTP upload tool, it automatically looks to
see what documents you have open. If you need to add other f
such as images, Click Add. To remove files from this list, selec
the files you do not wish to upload and click Remove.

8 When you are ready to upload your files, click Upload.

WebEdit PRO will prompt you to save any files that have not be
saved since they were last modified, dial your ISP (if you are n
connected), and automatically transmit your files.

The first time you send files with WebEdit PRO's FTP upload to
you should double-check with your Web browser to make sure 
files went where they were supposed to go. 

If the files are not where they are supposed to be, double-check
Directory on FTP Server field on the Server tab.

The next chapter describes WebEdit PRO’s configuration optio

Field Description

User ID Enter your FTP user ID, if applicable.

Password Enter your FTP password. if applicable.

Account Enter your FTP account number, if applica-
ble.

Save Password Select this option if you want WebEdit 
PRO’s FTP Upload tool to remember your 
password.
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Overview
WebEdit PRO provides many customizable features, so that you
configure it to suit your work style and preferences. This chapte
describes how to access WebEdit PRO’s configuration options 
the what each option does.

Accessing Configuration Options
WebEdit PRO includes extensive configuration options.

To access the configuration options:

• Choose Configure from the Options menu. The Options dialo
displays, with seven tabs.

Options dialog

Tip
To get help for any configuration option, rest the mouse pointer
the text or control for a few seconds; a popup tooltip will give a br
explanation of what the option does.
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The following sections describe the options found on each of th
tabs in the Options dialog. 

Preferences

Options - Preferences dialog

Option Description

Drag and drop be-
havior

Insert a dragged file as tag (such as link or
image) or open the file in a new document 
window.

Lower case file-
names

Use lowercase for names of saved files 
(required for some version of Unix).

Word wrap Wrap text in document windows.

Open new docu-
ment at startup

Create an empty document window each 
time WebEdit PRO is started.
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Color Options

Options - Color dialog

Option Description

Use syntax high-
lighting

Display tags in a contrasting color.

Toolbar Select which toolbars to display by default.

Browsers Select which version of available browsers t
launch when the View Document with 
Browser command is used (different browse
versions support different sets of HTML 
tags, so you can use this option to test you
pages in different browser versions).

Configure user 
toolbar

Opens the user toolbar configuration dialog

Add or Edit 
Browser 

Opens a dialog where you can select which
browser to open when the View Document 
with Browser command is used, or add othe
browsers to the list of available browsers.
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Font Options

Options - Font dialog

Option Description

Document Text The color of normal text in the document 
windows.

Document Tag  The color of HTML tags in the document 
windows (the "Use syntax highlighting" 
option in the Preference tab must be on to 
display the color you select here—see 
above).

Previewer Text The color of text in the Quick Preview 
window (where the color has not been explic
itly set using HTML tags).

Previewer HotSpot The color of link text in the Quick Preview 
window.

Use Default ColorsReturn the color scheme to the default.
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File Options

Options - Files dialog

Option Description

Select Font Select Editor to set the default font for the 
document (editing) window, or Previewer to
set the default font for the Quick Preview 
window.

Note: The font choices you make here only
affect your system; they do not determine th
fonts that will be used by browsers that ac-
cess your pages. Use the <FONT> tag in yo
documents to specify the font that others wi
see in their browsers.

Name Select the font name.

Size Select the font size.

Style Select Bold and/or Italic, if desired. When 
neither is selected, the font style will be 
plain.
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Previewer Options

Options - Previewer dialog

Option Description

Directory Select the directory where you want to stor
WebEdit PRO configuration files. These in-
clude all URLs that you enter in dialog boxe
(so that you can select them from pick lists
rather than retyping them).

Default extension If you are using Windows NT and WebEdit 
PRO’s File Open dialog displays each 
HTML filename twice, choose the "HTML 
only" option in this tab.
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Option Description

Display Previewer If selected, the Quick Preview window is 
displayed by default when you start WebEd
PRO.

Full Window Pre-
view

Sets the Quick Preview window to display 
full-screen

Automatically Up-
date Previewer

If this option is on and the Quick Preview 
window is displayed, the Quick Preview win
dow reflects changes made in the docume
window as they are made (can lag behind 
your typing if large images have to be load
ed).

Show Pictures Set this option on if you want the Quick 
Preview window to display images specified
by the HTML in the document window; 
otherwise a placeholder is used instead of t
image.

Orientation Select how you want the screen to be split 
between the document window and the 
Quick Preview window (side by side or 
above and below).
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Blank Lines Before/After Tags

Options - Carriage Returns dialog

Use the check boxes in this tab to insert a blank line—Carriage
Return and Line Feed—before ("Begin") and/or after ("End") th
corresponding HTML tags. You may want to set some of these 
options to make your HTML documents more readable to you.
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Tag and Path Options

Options - Tags & Paths dialog

Option Description

Tag case Choose how you want WebEdit PRO to 
format HTML tags that it inserts into your 
documents. This setting does not affect 
existing tags.
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Option Description

Pathing Select how you want WebEdit PRO to ente
file paths when you enter a filename to be 
included inside an HTML tag. If you select 
"Relative to a fixed directory," you must 
specify the directory under "Fixed directory"
(see below). Select one of the following 
options:

• None - Do not include any path informa-
tion for the file.

• Absolute - Include the file’s entire actual 
path.

• Relative - Append the file’s path (follow-
ing the root directory) to the document’s 
path.

• Relative to a fixed directory - Append 
the file’s path (following the root direc-
tory) to the path specified under "Fixed 
directory."

Reverse Slashes f selected, Unix-style "forward slashes" are
used in paths; otherwise, DOS "backslashe
are used.

Fixed directory If you select "Relative to a fixed directory" 
under Pathing, you need to specify that dire
tory here. Use the Browse button to locate th
directory you want.
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Project Options

Options - Project dialog

You can keep track of files that belong to a given project using 
WebEdit PRO’s Project Manager. When starting a new project,
choose Project from the File menu, then select New to launch t
Project Manager. Once you have saved a project, you can open
choosing Project from the File menu, then selecting Open. WebE
PRO project files have a .WEP extension.

Option Description

Extended Function-
ality

When selected, the Project Manager windo
visually differentiates files according to their
status, as follows (this slows performance 
somewhat):

• Project file not loaded in WebEdit PRO 
(indicated by a plain icon)
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The next chapter provides a basic introduction to HTML, and 
explains how to use special characters, user-defined tags, and
server-side includes in your HTML documents.

Option Description

Extended 
Functionality 
(cont.)

• Project file that is loaded in WebEdit PRO
(indicated by a pencil-tip icon)

• Loaded project file that has been modified
since it was loaded (indicated by a penci
tip icon and boldface filename)

• Project file that could not be found 
(indicated by a red X) 

Close open docu-
ments on Project 
Manager shutdown

When selected, exiting Project Manager wil
first save and close all open files related to
the project.

Stay on top When selected, the Project Manager windo
stays on top of all other open windows.
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Overview
This chapter provides an introduction to the most commonly us
HTML tags, and describes several advanced HTML features of
Web Edit PRO. You will also learn how to convert existing 
non-HTML documents into HTML documents.

The description of HTML in this chapter covers only the basic ta
to help you get started. Once you have the essential concepts,
can let WebEdit PRO take care of the work of generating the HT
tags for your documents, while you concentrate on the page lay
and content.

When you want to learn more about a specific HTML tag or its 
attributes, you should consult the comprehensive online HTML 
Reference that is included in WebEdit PRO’s Help system. This
online reference encompasses HTML Levels 0 through 3.2, an
includes Netscape- and Internet Explorer-specific additions.

In addition to presenting HTML basics, this chapter includes th
following more advanced topics:

• Special characters—how to include "markup" characters (suc
as ">") math symbols, foreign language characters, etc., in th
text of HTML documents.

• User-defined tags—how to easily define your own custom ta
such as frequently used tag combinations or text.

• Server-Side Includes (SSIs)—the purpose of SSIs, how they
work, and how to access WebEdit PRO’s online SSI referenc

At the end of this chapter is a list of recommended HTML resour
on the Web that you can add to your bookmarks or favorites lis
your browser.

HTML Concepts
The concepts of HTML elements, tags, attributes, and values are 
described in this section.
 Introduction to HTML, 6-3
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 



WebEdit PRO User’s Guide
. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

ou 

-than 

 
not 

in 
>, 
 

w 

 ba-
Element - Any "building block" of an HTML document, such as 
heading, body, link, image, table header, list item. Everything y
see in a Web page is some kind of element.

Tag - A symbol that identifies an element to an HTML browser. 
Tags are enclosed in angle brackets (the greater-than and less
symbols, < and >). Most tags are really tag pairs, such as the 
following:

<A> and </A> - hyperlink

<B> and </B> - boldface

<TABLE> and </TABLE> - table

Note the slash ("/") in the second tag; it indicates that the tag is a
"closing" or end tag. The following are examples of tags that do 
come in pairs:

• <BR> - line break

• <P> - new paragraph

• <HR> - horizontal rule

Attribute  - A characteristic of an element that can be defined with
the tag for that element. In the link tag <A HREF="mydoc.html"
HREF is an attribute of the link element. In the inline image tag
<IMG SRC=myphoto.gif>, SRC is an attribute of the image 
element. (Ongoing extensions to HTML are for the most part ne
attributes than can be included in tags.)

Value - How an attribute will appear (or what it is, or what it will 
do) in a specific instance of an element. In the link tag <A 
HREF="mydoc.html">, "mydoc.html"  is the value of the HREF 
attribute. In the body tag <BODY BGCOLOR="NAVY">, 
"NAVY" is the value of the BGCOLOR attribute.

HTML Document Structure
At the most general level, every HTML document has the same
sic structure, indicated by the following required tags: 
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<HTML>

<HEAD>
(...head elements go here...)
<HEAD>

<BODY>
(...body elements go here...)
<BODY>

<HTML>

This "minimal" HTML markup can be inserted into any docume
in WebEdit PRO with a single click (see the "Using the Minimal
HTML Feature" section in Chapter 3).

Basic HTML Tags
HTML documents consist of elements plus markup (formatting)
tags that tell HTML browsers (viewing software) how to display t
elements. This section defines the basic HTML tags which can
placed in any text document (created by any application) to tur
into an HTML document that can be viewed in any browser. A 
complete reference on HTML tags is included in WebEdit PRO
online Help.

Identifying the document as an HTML document
<HTML> and </HTML>
To identify a document as an HTML document, you must start t
document with the <HTML> tag and end the document with a 
closing tag </HTML>. You include the rest of the document with
the boundaries of these two tags.

Paragraph Breaks
<P>
To place a paragraph break (blank line) in the document, use th
<P> tag at the location where you want the blank line to appea
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Line Breaks
<BR>
To place a line break in the document, use the <BR> tag after t
text where you want the line to break.

Using Preformatted Styles
<PRE> and </PRE>
HTML uses this tag to quickly allow you to center text in a differe
monospace typeface (similar to Courier). Place the opening tag
<PRE> before the text you want to tag and the closing tag </PR
after the final piece of text.

Header Text
<HEAD> and </HEAD>
To identify the document header, use the opening tag <HEAD>
the beginning of the header text and the closing tag </HEAD> a
the end of the header text.

Body Text
<BODY> and </BODY>
Place the opening tag <BODY> at the beginning of the main body 
text and the closing tag </BODY> after the main body text.

Titles
<TITLE> and </TITLE>
To add a title to the document, use the <TITLE> tag before the t
text and </TITLE> after the title text.
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Footer Information
<ADDRESS> and </ADDRESS>
To add your e-mail or domain name address to the footer of the
document use the <ADDRESS> tag above the text and the </A
DRESS> tag below the text.

Section Headers
<H1> and </H1> through <H6></H6>
Up to six header levels can be applied using these tags before
after the header text. Each header level is given a font and char
attribute in descending sizes.

Horizontal Rules
<HR> 
Use this tag on any line where you wish a horizontal line ("rule") 
to appear.

Bold Text
<B> and </B>
Use these tags before and after text to make the text bold.

Italic Text
<I> and </I>
Use these tags before and after text to make the text italic.

Underline Text
<U> and </U>
Use these tags before and after text to add an underline to the 
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Monospace Text
<TT> and </TT>
Use these tags before and after text to make the text monospaced 
(similar to Courier).

Identify a Definition List 
<DL> and </DL>
Identifies the beginning and ending of a definition list.

Definition List Term
<DT> 
Use this tag before the text you wish to identify as a term in the

Definition List Description
<DD> 
Use this tag before the text you wish to identify as a definition in 
list.

Bulleted Lists 
<UL> and </UL>
Identifies the beginning and ending of a bulleted list.

Bullet List Item
<LI> 
Use this tag before the text you wish to identify as a bulleted item
the list.

Numbered (Ordered) Lists
<0L> and </0L>
Identifies the beginning and ending of a numbered list.
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Numbered List Item
<LI> 
Use this tag before the text you wish to identify as a numbered i
in the list.

Jumps to Other Web Pages
<A> and </A> using HREF=
To identify text as a hypertext jump to another Web page, use t
<A> tag before the text and the </A> after the text. The URL of
where you want to jump is included in the <A> tag with the HREF
tag; for example, <A HREF="http://www.whitehouse.gov/"White
House</A>. URLs are enclosed in double quotes. In this exam
when the user clicks on the text White House they will jump to the 
specified white house server name. Links are automatically und
lined.

You can use the same syntax to jump to other .HTML pages, ra
than other servers.

Adding Graphics
<IMG> SRC=filename
To place a graphic in the document, use the following tag synta
<IMG SRC="sample.gif"> which identifies the graphic name.

Comments

To include comments in an HTML document that will be ignore
by the browser, surround them with <!-- and -->. After the begin-
ning comment delimiter, all text up to the next occurrence of -->
ignored. The following example includes a comment:

<HEAD>
<TITLE>My Home Page</TITLE>
<!-- Created 01/08/96  -->
</HEAD>
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Converting Documents to HTML
In most cases, you will want to convert any existing documents
be stored on the Web server into HTML documents. This will 
ensure cross-platform compatibility and conform to WWW 
document standards.

To convert your existing documents:

1 Save your document as an ASCII text file. Unfortunately, graph
and pre-existing formatting cannot be imported into an HTML fil
You’ll have to add these once you have your text imported.

2 Start WebEdit PRO.

3 Choose Open from the File menu.

4 In the Open dialog, select the text file that you want to convert 
an HTML file and click OK. (You may need to select Text Files 
All Files in the Files of Type drop-down list.)

5 Insert the HTML tags, images, and so on, as described earlier 
this chapter.

6 Save the file in WebEdit PRO. The file is now an HTML file.

Using Special Characters
Certain characters such as the greater-than symbol and ampers
are interpreted as markup by HTML browsers; they will not be 
displayed unless you enter them using a special format. Other 
characters such as foreign language characters, math symbols
symbols like "™" also need to be entered using a special forma
WebEdit PRO provides an easy way to enter these types of 
characters with the Special Characters feature.

To insert a special character:

1 Choose Special Characters from the Insert menu, or click the 
Special Characters button in the user toolbar. The Special 
Characters dialog displays.

2 Select the tab that includes the symbol you want to insert.
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3 Click Add to insert the symbol or Replace to replace text you ha
already entered in the HTML document.

4 Click the character you want to insert.

Creating Custom Tags
If there are any tags or text elements that you regularly add to y
documents, but which are not among the tags supported by Web
PRO, you can add your own custom tags with the "user-defined
tags" dialog box.

To add a new tag or text element:

1 Click the Custom button on the menu toolbar and select Add o
Edit Custom Tags. Or choose User-Defined Tags from the Inse
menu, then select Add or Edit Tags. The User-Defined Tags dia
displays.

User-Defined Tags dialog

2 Select the Add button on the User-Defined Tags dialog box.

3 Add the new tags.

4 When done, click OK.
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To insert this tag into a document, click the Custom button on t
menu toolbar and select the tag you wish to enter. Alternatively, 
can use the shortcut key WebEdit PRO assigns for each item on
menu (the Alt key plus a sequential number). You can also acc
user-defined tags by choosing User Defined Tags from the Inse
menu and selecting User Tags to display a list of tags.

User-defined tags work just like WebEdit PRO’s built-in tags; if 
you have both a begin and end tag, you may highlight your text f
Inserting the tag will then put the begin tag at the beginning of t
selected text and the end tag at the end.

You can also specify the name of a text file as a user-defined ta
e.g., c:\wwwwroot\myfile.html. Choosing this tag causes the 
contents of the file myfile.html to be inserted into the active 
document at the current insertion point.

Server-Side Includes
This section provides a brief introduction to server-side include
(SSIs). Server-side includes are special markup tags that you c
use in your HTML documents. The SSI tags, variables, and data
are supported by WebEdit PRO are described, with examples, 
WebEdit PRO’s online help; choose Server Side Includes from 
Help menu to access the SSI online reference.

Important!
In order for you to be able to use SSIs in your HTML document
the HTTP server where your document are stored must be SSI
enabled by the system administrator.

The idea behind SSI is to be able to include additional informat
in an HTML document just before it is sent from the server to th
browser that requested it. The server replaces each SSI directi
with the result of executing that SSI directive—thus "server-side
includes." The person viewing your document never sees the S
directives themselves.

The following are examples of uses for SSIs:

• Insert the local date and time into your document.
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• Include the name of the person using the remote client (brow
in your document—most likely this will be the person’s e-mai
address.

• Insert the date and time a document was last modified into y
document.

• Insert an entire file into your document.

• Execute programs stored on the server and insert the output
your document. This ability to execute programs on the serve
the reason the server must be SSI-enabled by a system adm
trator.

• Query an ODBC-compliant database with SQL statements a
insert the returned data into your document.

• Use if , goto, and label SSI tags to conditionally execute SSI 
commands and print document contents.

SSI tags use the HTML comment format and add a special chara
denoting that it is an SSI tag: # (the pound sign). As mentioned in 
the previous section, the format for HTML comments is:

<!--  this is a comment-->

The SSI start tag adds the pound sign, as in the following exam

<!--#exec cgi="myfile.cgi"-->

The SSI end tag is the same as the comment end tag.

WebEdit PRO includes a complete online reference for the SSI t
variables, and data that it supports. To access the online SSI re
ence, select Server Side Includes from the WebEdit PRO Help 
menu. In the Server Side Includes main help topic, choose the SSI 
Tags, Variables and Data topic for explanations and examples.

Important!
You should save HTML documents that contains SSIs with the
.shtml (or .shtm, or .sht) extension. If the server has been SSI-
enabled, it has probably been set up to examine (parse) a file f
SSIs only if it has one of those extensions.
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For More Information
HTML and the Web are still in their infancy and growing rapidly
The HTML Reference in WebEdit PRO’s online Help is quite 
extensive and clearly indicates the HTML version or proprietary
browser version where a tag or attribute originated. Of course, 
may not include all of the most recent information.

In addition, other developments such as Cascading Style Sheet
relatively new on the HTML scene (as of this writing) and have n
yet been incorporated into WebEdit PRO’s online help. A usefu
reference for style sheets is given below.

The documents available at the following Web locations will hel
you keep abreast of developments as well as help you broaden
deepen your knowledge of HTML.

• The Yahoo Collection of HTML Tutorials and Guides:

http://www.yahoo.com/Computers_and_Internet/
Software/Data_Formats/HTML/Guides_and_Tutorials/

• The official HTML specification:

http://www.w3.org/pub/WWW/MarkUp/

• A comprehensive collection of HTML specification and 
reference documents:

http://www.sandia.gov/sci_compute/html_ref.html

• The Cascading Style Sheets Level 1 (CSS1) specification:

http://www.w3.org/pub/WWW/TR/WD-css1

You will also find a range of HTML guides and references, from
beginner to expert, at most larger bookstores or computer store
Especially recommended for finding quick how-to answers to 
HTML questions is Elizabeth Castro’s Visual QuickStart Guide: 
HTML for the World Wide Web (PeachPit Press).

Luckman Interactive is dedicated to bringing you the best in We
publishing tools, and we wish to thank you again for choosing 
Luckman Interactive’s WebEdit PRO!
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Address
The location of a computer or document (graphic, file, etc.,) on the Internet. Eac
Internet computer has a unique IP Address. Each file or document has a unique
address. Every person has a unique e-mail address.

Anonymous FTP
Allows you to log on to an FTP computer without using a unique password or lo
ID for file transfers only. Instead you use the word “anonymous” as the user ID 
your e-mail address as your password.

Archie
A software program allowing you to search, view and retrieve public domain file
from FTP hosts. There are more than 1,000 Archie sites on the Internet.

ASCII
American Standard Code for Information Interchange. The most common chara
code used on PCs and for communication, ASCII consists of 128 upper and lowe
letters.

Authentication
A procedure for verifying the identity of parties during an electronic corresponde

Basic authentication
A form of authentication for HTTP that requires a username and password.

Bandwidth
A measurement of the amount of data that can flow through a communications c
per second.

Baud rate
Measures the rate by which a modem converts signals into sounds allowing the
be sent over an analog telephone system.

Binary file
A file that contains characters other than standard ASCII characters. You cannot
binary files (and make since of them). For example, all executable programs are b
files.

Bit
Binary digit. This is the primary computer unit of information. A bit is either 1 or 

BPS
Bits per second. The measurement of the data transfer rate of a computer netw
modem (how fast information is transferred).
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Bookmark
A method for marking sites or documents to allow for easy return. 

Browser
Application that interprets and displays documents from the World Wide Web.

Byte
The smallest addressable unit in a computer. A byte consists of eight bits.

Case sensitive
Able to distinguish between uppercase (capital) letters and lowercase letters.

CGI
Common Gateway Interface. CGI scripts allow you to add advanced features to
Web site.

Client
A program that requests services from another computer (the server). For exam
Gopher is a “client” used to contact Gopher servers while Internet Explorer is a 
ent” for the WWW.

Connection
The physical link between two computers on a computer network where both com
ers are then ready to exchange information.

Database
An organized collection of information on a single topic or group of related topic

Directory
A method for organizing files hierarchically under a common directory name.

Download
Transfer a file from a host computer to your computer’s hard disk using your mo

DNS
Domain Name Server. Used to translate hostnames into Internet addresses.

E-Mail
Electronic mail allowing you to send mail over the Internet.

Extension
One to three characters that are added after a period to a file name to help clar
type of information contained in the file.
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FAQ
Frequently Asked Questions. Web sites often contain FAQs allowing you to acce
most frequently asked questions about the site.

Finger
A client application that lets you obtain a list of users currently logged onto a ho
system. 

Firewall
A gateway between a computer and the Internet that protects the computer from
thorized access.

Freeware
Software available without charge through the Internet.

FTP
File Transfer Protocol. Used to upload/download Internet files.

Gateway
Hardware or software that translates data between two normally incompatible p
cols.

Gopher
A software client program that allows you to locate, view and retrieve informatio
from a Gopher information server.

Gopherspace
The searchable computer space on worldwide Gopher servers.

Graphics Interchange Format (GIF)
Graphics format widely used to exchange graphic files. GIF files are stored usin
.GIF extension and are compressed to improve transmission speed.

Header
The portion of an e-mail message or UseNet posting containing the sender’s an
cipient’s addresses and subject matter.

Home page
The default page for a World Wide Web site, corporate site or personal user site
home page usually tells you where you are at, provides a brief description of wha
be found at the site, and provides the links to access the site’s available information

Hot List
A file allowing you to store favorite WWW sites or documents for easy future acces
G-4, Glossary
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HTML
HyperText Markup Language. A set of markup tags used to write documents on
World Wide Web.

HTTP
HyperText Transport Protocol. This protocol makes browsing the World Wide W
possible by clicking on links that are established in a Web document and moving
to that document, even though it may be located on another computer.

Hypermedia
Provides the ability to integrate text, sound, graphics, or video in a single docum

HyperText
Data which provides links to other items in the same document or in other docum
allowing you to move through information in a non-sequential fashion.

IP Address
A unique Internet address. This is a 32-bit address containing a host component
network component that identifies the location of an Internet host.

Internet Relay Chat (IRC)
A real time, multi-user client program that allows you to talk (or chat) with other
Internet users interactively on a variety of subjects. These conversations are te
based.

ISDN
Integrated Services Digital Network. A digital communications network that can c
voice, data, and video transmissions at 128K per second.

ISP
Internet Service Provider. The organization that provides Internet access.

JPEG
Joint Photographic Experts Group. A digital compression standard used for ima

MIME
Multipurpose Internet Mail Extension. A standard protocol for sending multimed
file types by e-mail and on the Web.

MPEG
Motion Pictures Experts Group. Standard for compressed movie images.
 Glossary, G-5
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Network
A network is the method by which computers share information with each other
These may consist of a local area network (LAN) connecting up to about 100 co
ers located in a relatively confined area or a wide area network (WAN) connecti
computers over larger (even worldwide) distances.

Newsgroups
A UseNet discussion group on a particular topic. Over 11,000 newsgroups curre
exist on the Internet.

Packet
Basic unit of Internet data. Files are assembled into packets, each marked with
address of where it is going. Once all packets arrive at their final destination, the
reassembled in their original format.

PPP
Point-to-Point Protocol. A method for exchanging data packets on the Internet o
telephone line.

Post Office Protocol (POP)
Provides a means for storing incoming e-mail messages until you log on and dow
them to your computer.

Protocol
Defines how computers communicate. A protocol is an agreement between diff
systems on how they will work together.

Read only
Ability to read a document but not to change it.

Router
A computer that determines which path Internet traffic will use to reach its destina

Server
A computer that provides a resource on the network. Client programs access se
to obtain data.

Service provider
An organization that provides Internet access or communication links.

SLIP
Serial Line Internet Protocol is a software program used by a dialer to tell your c
puter how to communicate with another computer.
G-6, Glossary
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TCP/IP
Transmission Control Protocol (TCP) and Internet Protocol (IP) are software for
managing Internet data packets on your computer. TCP/IP is the protocol which
allows you to communicate with the Internet.

Telnet
An Internet protocol that allows you to log on to a remote computer.

Terminal emulation
Communication with a remote computer where your computer acts as a termina
connected to the remote computer.

Thread
A topic or subject in a newsgroup that has received one or more follow-up postings

URL
Uniform Resource Locator. The Internet address which specifies the exact locati
a service or document on the World Wide Web.

UseNet
A worldwide network of newsgroups covering thousands of topics.

VRML
Virtual Reality Modeling Language allowing for 3-D simulations on the Web.

WAIS
Wide Area Information Server. An indexing tool for keyboard searches of text d
ments.

.WAV files
Filename extension for a Window audio file.
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